
Product Overview

Genie Mail Backup™ (GMB), is a very easy to use yet powerful and flexible software that can backup and
restore files, Outlook, Outlook Express,  Windows Mail, Windows settings, and more to virtually any local or
remote location, including internal and external hard disks, FTP locations, across network, optical media,
removable media,  and memory sticks. GMB also offers offsite (online) backup service. GMB is the successor
of Genie Outlook Backup and Outlook Express Backup merged in one product with more powerful and
enhanced features.

GMB is perfect for users of all computer comfort levels. Novice users will find it easy to create their first
backup job in matter of minutes after installing the software, thanks to its intuitive wizard-based user
interface, while advanced users will appreciate the software's extended scalability and flexibility, with
features such as Email notification, Self restorable backups.

GMB also caters for the data protection needs of business enterprises, by offering features that ensure a
reliable backup mechanism for mission critical data, such as backing up using Open File Backup (OFB), for
businesses operating around the hour that cannot afford to shutdown its running applications during backup,
highly secure encryption, for sensitive documents that must not fall into the wrong hands and scheduling
unattended backup tasks for regularly safeguarding constantly changing data.

Online backup is our latest offering for users who wish to protect their emails and important files, without
the hassle of maintaining shelves of stacked backup desks or cartridges, by performing true offsite backups
to Genie-Soft's backup servers. Our online backup solution ensures around-the-hour data accessibility, and is
highly secure, through username and password encryption, as well as 128- bit Secure Socket Layer (SSL)
data transmission, certified by the leading global provider of SSL certificates, Thawte.

As we introduce GMB, we are confident that it can efficiently and effectively address all your data protection
needs. Let GMB work for you and never again worry about losing that which you have spent years building or
collecting.
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Feature Matrix

Genie-Soft offers a variety of backup and recovery products, each priced and carrying a set of features
tailored to cater for the needs of different categories of users. Genie Backup Manager comes in three
editions: Server, Pro and Home.

Server Has the majority of functions enabled, while Pro and Home are the somewhat limited-functionality
editions. Genie-Soft also provides Genie Mail backup for protecting emails which has the least features.

Below you can find a comparison of the features available in each edition.

Product Name
Genie Backup

Manager
Server V 7.0

Genie Backup
Manager
Pro V 8.0

Genie Backup
Manager

Home V 8.0

Genie Mail
Backup V 8.0

Features        

Built in CD/DVD burning
capability

Backup Outlook Express

Backup Outlook 2000-2007

Backup Windows Mail

Backup Windows Contacts

Create Outlook Profiles

Backup Files & Folders files only



Backup My photos  

Backup media Files & playlists

Backup My Documents

Backup Programs

Backup Desktop

Backup Favorites

Backup Internet Explorer
Settings

Backup Windows Address Book
(WAB)

Backup Windows Settings

Backup Fonts

Automatic Backup Scheduler

Advanced Backup Scheduler



AES Encryption

Purging

Pre & Post Commands

GenieScript: create custom
backup scripts

Backup File Integrity Testing

Backup your data with or
without compression

Backup as EXE file (To any
medium)

Backup to a remote FTP
Server
(Unlimited size)

Integrated Online Backup

On-The-Fly Compression

Auto Update



Automatic Media Spanning

Backup to Tape

Email Notification

Catalog

CPU Management

MS Exchange

SQL Server

Bandwidth Throttling coming soon

Backup Performance (Speed)

Logs Manager

Differential Backup

Backup to REV

Disaster Recovery coming soon



Manual File/Folder Selection

Control backup performance coming soon

Date and file size filtering coming soon

Snooze Scheduled backup coming soon

Backup Access Control List

CRC data verification

Backup transfer method

Pause Backup coming soon

Mirror Backup

         

Price $ 400 $ 69.95 $ 49.95 $ 34.95
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What's New In Version 8.0?

Combined Two Products in One

GMB is the successor of Genie Outlook and Outlook express backup all in one

Added support of Backing up on Vista Platforms

Now GMB has the ability to backup all your critical data on the new Vista platform. It also added support to
backup Windows Mail and Windows Contacts; the successors of Outlook Express and Windows Address Book
(WAB)

AES Encryption

Replaced blowfish encryption with more secure AES encryption that is classified to be secure enough to
backup US governmental documents

More info...

Added Catalog

Now you can search, extract, and view backed up items without the need for the restore wizard

More info...

Free Open File Backup Option

GMB currently added Microsoft's latest Volume Shadow-Copy Service (VSS) framework, to permit consistent
backup of locked and open files without the need for additional applications or plug-ins.

More info...

Online Backup Integration

Now you can backup your important data Online with the fully integrated Genie Online backup in

More info...

Enhanced Purging Option

Now there is no need to depend on the timestamp to purge accumulating backups. You can purge by number
of backup sets or by date. Also, rotate between Full and incremental backups.

More info...

Improved Scheduling Capabilities

Now it is easier to protect and rotate backups with the intuitive easy to use scheduling interface that is
integrated in the backup wizard.



More info...

REV  Support

Now with the new Iomega REV  support, users can automatically erase, enable/disable write and password
protection before and after backup.

More info...

Improved Connectivity:

GMB now detects when backup destination is accessible and also auto resumes when connection returns.

Enhanced Graphical User Interface

Now more organized with clear options making GMB’s interface better than ever.

Control Power Options

You can enable/disable power options or change them during scheduled backups.

More info...

Pause/Snooze Backups:

You can pause currently running backups and postpone scheduled backups to start later via snoozing

More info...

New Compression Engine:

Replaced the 32-bit zip engine with 64-bit compression to eliminate the 2 GB splitting limitation.

More info...
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Copyrights

Copyright© Genie-Soft Corporation 2002-2007. All rights reserved.

Warning: This computer program is protected by copyright law and international treaties. Unauthorized
production or distribution of this program, or any portion of it that's owned by Genie-Soft, may result in
severe civil and criminal penalties, and will be prosecuted to the maximum extent possible under the law.

Outlook Express®, Outlook®,Internet Explorer®, Windows® and Microsoft® are Registered Trademarks of
Microsoft® Corporation

All trademarks and registered trademarks used in this documentation are property of their respective
owners.
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End User License Agreement

END LICENSE AGREEMENT

PLEASE READ THIS DOCUMENT (THIS "AGREEMENT") CAREFULLY BEFORE USING THE SOFTWARE PROVIDED
ALONG WITH THIS AGREEMENT (THE "SOFTWARE").  BY CLICKING "I ACCEPT THE TERMS IN THE LICENSE
AGREEMENT", YOU AGREE TO THE TERMS OF THIS AGREEMENT AND TO THE GENIE-SOFT PRIVACY POLICY,
WHICH IS INCORPORATED IN THIS AGREEMENT AND CAN BE FOUND AT GENIE-SOFT’S WEBSITE
(HTTP://WWW.GENIE-SOFT.COM/ABOUTUS/PRIVACY.HTML).  IF YOU DO NOT AGREE TO THE TERMS OF
THIS AGREEMENT, IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, PROMPTLY DELETE AND
DESTROY ALL COPIES OF THE SOFTWARE.

Versions of the Software

There are two versions of GENIE MAIL BACKUP  EDITION (registered and evaluation), each of which is
subject to this Agreement. UPON ORDERING, DOWNLOADING, INSTALLING OR USING ANY VERSION OF THE
SOFTWARE, YOU ARE REAFFIRMING THAT YOU ARE BOUND TO THE TERMS OF THIS AGREEMENT.

The registered version requires registration with Genie-Soft.com Corp., Which includes payment of the then
current license fee. The evaluation version is the only version that is provided without charge; however, the
evaluation version is not free software.  All rights and licenses to the evaluation version automatically expire
30 days after first installation, after which you must register with Genie-Soft.com Corp. and pay the then
current license fee. Payment must be in US dollars drawn on a US bank.  For details on registration methods,
please refer to the help file in the software, or contact Genie-Soft.com Corp.

License to Use

One copy of the evaluation version of GENIE MAIL BACKUP  EDITION may be used by a single person for
evaluation purposes without charge up to 30 days.  Subsequent downloads of the evaluation version by or
for the same user do not extend, renew, or otherwise restart the term of the license for the evaluation
version.

One copy of the registered version of GENIE MAIL BACKUP  EDITION may be used by a single person who
uses the software personally.  The registered version of GENIE MAIL BACKUP  EDITION may not be rented,
loaned, leased, licensed, or otherwise used, by anyone other than the individual who has registered the
software.

Site licenses for GENIE MAIL BACKUP  EDITION may be obtained from Genie-Soft.com Corp which cover
multiple users at one location or multiple users within a business entity.

You may make a reasonable number of copies of the registered version of the software for backup and
archival purposes. You also agree that you may not reverse assemble, reverse compile, or otherwise
translate the Program.

No Additional Licenses

All rights to the GENIE MAIL BACKUP  EDITION software and documentation not expressly granted under this
Agreement are reserved to Genie-Soft.com Corp. You may not translate, decompile, disassemble or reverse
engineer the GENIE MAIL BACKUP  EDITION software or documentation.

Costs of Litigation.

If any action is brought by either party to this License Agreement against the other party regarding the



subject matter hereof, the prevailing party shall be entitled to recover, in addition to any other relief
granted, reasonable attorney fees and expenses of litigation.

Disclaimer of Warranty

THIS SOFTWARE AND ACCOMPANYING DOCUMENTATION ARE PROVIDED "AS IS" AND WITHOUT
WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER
EXPRESSED OR IMPLIED.   BECAUSE OF THE VARIOUS HARDWARE AND SOFTWARE ENVIRONMENTS INTO
WHICH GENIE MAIL BACKUP  EDITION MAY BE USED, NO WARRANTY OF FITNESS FOR A PARTICULAR
PURPOSE IS OFFERED.  IN PARTICULAR, GENIE-SOFT.COM CORP SHALL HAVE NO LIABILITY FOR ANY DATA
STORED OR PROCESSED WITH THIS SOFTWARE, INCLUDING THE COSTS OF RECOVERING SUCH DATA. THE
USER MUST ASSUME THE ENTIRE RISK OF USING THIS PROGRAM. ANY LIABILITY OF GENIE-SOFT.COM
CORP. WILL BE LIMITED EXCLUSIVELY TO PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE.  

NO LIABILITY FOR CONSEQUENTIAL DAMAGES.  TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW,
IN NO EVENT SHALL Genie-Soft OR ITS SUPPLIERS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR
CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF
PROFITS, BUSINESS INTERRUPTION, CORRUPTION OF FILES, LOSS OF BUSINESS INFORMATION OR ANY
OTHER PECUNIARY LOSS) REGARDLESS OF CAUSE OR FORM OF ACTION, INCLUDING CONTRACT, TORT OR
NEGLIGENCE, ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE PRODUCT, EVEN IF
Genie-Soft HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  BECAUSE SOME STATES AND
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY OF CONSEQUENTIAL OR
INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

LIMITATION OF LIABILITY

Genie-Soft'S ENTIRE LIABILITY AND YOUR EXCLUSIVE REMEDY UNDER THIS END USER LICENSE SHALL NOT
EXCEED ONE DOLLAR (US $1.00).

USE OF THIS PRODUCT FOR ANY PERIOD OF TIME CONSTITUTES YOUR ACCEPTANCE OF THIS AGREEMENT
AND SUBJECTS YOU TO ITS CONTENTS.

SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES SO THIS LANGUAGE MAY
NOT APPLY. IN SUCH CASE, GENIE-SOFT.COM INC'S LIABILITIES WILL BE LIMITED BY THE ABOVE
LIMITATION OF REMEDIES PROVISION.

US GOVERNMENT RESTRICTED RIGHTS

Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subdivision
(b)(3)(ii) of  the Rights in Technical Data and Computer Software clause at  25 2.227-7013.
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GMB System Requirements

Windows 2000:

Hard drive with at least 25MB free disk space for installation

512 RAM

IE 5 or higher

133 MHz processor or faster

 

Windows XP:

Hard drive with at least 25MB free disk space for installation

512 RAM

IE 5 or higher

233 MHz processor or faster

 

Windows Vista:

Hard drive with at least 25MB free disk space for installation

512 RAM

IE 7

1 GHz Processor or faster
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How to: Install Genie Mail Backup

Installing from the downloaded file:

Run the downloaded .exe file and follow the on-screen instructions to install GMB.

 

To install from CD:

Insert the CD into your CD-ROM drive. Setup.exe will automatically be run. (If this fails to work, double
click the .exe setup file on the CD).

1.

Follow the on-screen instructions.2.

 



How to: Register Your Copy of GMB

Upon purchasing a GMB license, the user will receive an email containing a serial number for unlocking the
software and removing the trial period limitation.

To register GMB before the end of the trial period:

Start GMB.1.

From the toolbar, click Help then select Registration .2.

Type or copy-paste the serial number into its designated field then click OK.3.

 

 

To register GMB at a later date (30+ days after installation):

Start GMB.1.

A dialog will appear instructing you to register your software. Select Enter Serial Number then insert
your registration code..

2.

 

Online Registration



Registering your copy of GMB online after purchase will entitle you to receive prioritized technical assistance
via email (within 24 hours), MSN messenger and ICQ live online support and special discounts on other
Genie-Soft software titles and future releases.

Online registration is done by filling the online registration form on the Genie-Soft web site.

How to register GMB online?

Start GMB.1.

From the left navigation menu in the main screen select Online Registration.2.

Click Sign Up Now.3.

Follow the instructions on the registration page.4.



How to: Check for updates

The Genie-Soft support team regularly post updated builds of GMB with minor enhancements and fixes for
known issues. Registered users of GMB can use the Genie-Update tool to download the latest updates for the
software free of charge.

 

To check for updates:

From the Tools menu in the main screen, select Genie Update.1.

Select Next.2.

Follow the on-screen instructions.3.
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Open File Backup Agent's System Requirements

Supported Platforms:

Microsoft Windows 2000 and above (Windows 2000 / XP / Vista), running on Intel-compatible processors.

 

Windows 2000:

Hard drive with at least 20MB free disk space for installation

64 RAM

IE 5 or higher

133 MHz processor or faster

 

Windows XP:

Hard drive with at least 20MB free disk space for installation

128 RAM

IE 5 or higher

233 MHz processor or faster

 

Windows Vista:

Hard drive with at least 25MB free disk space for installation

512 RAM

IE 7

1 GHz Processor or faster
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How to: Install Open File Backup Agent

 

To install OFB from the Internet:

Run the setup file from the location to which you've downloaded it.1.

Follow the on-screen instructions.2.

Restart the computer.3.

To install OFB from a CD:

Close all programs.1.

Insert the CD labeled Genie Mail Backup into your CD-ROM drive.2.

From the Start menu, Select Run.3.

Type D:\OFB\OFB_setup_Final.exe (Substitute the appropriate letter of your CD-ROM drive for D).4.

Follow the on-screen instructions.5.

Restart the computer.6.
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How to: Register Open File Backup Agent

Upon purchasing a Open File Backup license, the user will receive an email containing a serial number for
unlocking the software and removing the trial period limitation.

To register OFB before the end of the trial period:

From the toolbar, click Help then select Register OFB Agent.1.

Type or copy-paste the serial number into its designated field then click OK.2.
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What Can GMB Do?

Genie Mail Backup is a powerful backup and restore utility designed to backup your emails, favorites,
contacts, and files, and settings.

Private users only need to back up files that they have created or modified themselves. Computers use both
program and data files; programs can be reloaded from the original discs, but your data can only be
reloaded from backup copies, which is where Genie Mail Backup comes into play.

Although Genie Mail Backup can reset the archive bit/flag of copied files during backup, determining which
files have been modified since the last backup run is done using the file's last modified date and time
attribute. This ensures that backup jobs are mutually independent, i.e. backing up a certain file with one
backup job does not prevent it from being backed up again by another.
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Managing Backup Jobs

Editing a Backup Job Configuration

You can use the Edit Previous Jobs button in the application's main window, then select a backup job to
modify its configuration. Another possibility would be to click Backup from the main window, and go to the
Job info page, select Edit Job, select a backup job from the list and click Load.

When the Properties window opens, go to the page with the settings you want to modify.

 

Deleting a Backup Job

Click Tools from the application's toolbar, select Jobs Manager, select a backup job, then click Remove.
The catalog entries for deleted backup jobs will be removed, but files and folders from the source and
destination will not be deleted.

 

Rename a Backup Job

Click Tools from the application's toolbar, select Jobs Manager, select a backup job, then click Rename...
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Backup Types

There are two basic types of backup supported by GMB. Selecting the best backup type for your purposes
depends on the storage media used, disk space considerations, and file version needs.

 

Full

Backup all selected files and folders every time backup is executed. A new independent backup set will be
created replacing files from older runs, unless the user explicitly opts to keep them by changing file purging
settings.

Full backup takes the longest time among all backup types.

Best used for one-time backups, such as for migrating personal files to a new computer.

 

Incremental

Backup only files that have been added or modified since the last backup. Files that were deleted, renamed
or moved from the source machine will not be deleted from the backup archive.

The first backup run will automatically backup all selected files and folders (i.e. run as if full backup
was selected).

Incremental backup with the rollback option enabled is best for spanning backed up data over
multiple storage volumes, such as CDs and DVDs, and for online and FTP backup.
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Data Verification

Verification ensures that backed up data was successfully written on the storage media and that it can be
restored reliably. Genie Mail Backup will by default verify backed up data immediately after the backup task
is completed. Users can also choose to test data integrity of a backup archive at a later time using the
Testing Data Integrity tool.

Testing data integrity is done using the following verification method:

Bit-by-bit verification: This is the default method used by GMB to verify that a backup archive is
restorable, and the data contained within it is not corrupt. This is done by reading every bit of each
backed up file, however, this verification method does not compare data to make sure that the backed
up and original versions of files are exactly identical. This means that if the contents of a file in the
backup archive were modified after backup, Genie Mail Backup will not detect it.
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File Versioning in Genie Mail Backup

Genie Mail Backup is great tool for maintaining numerous versions of backed up files; selecting incremental
backup with rollback will ensure that each time the backup job is run, updated files are appended to the
backup set instead of replacing older versions.

The catalog feature allows users to browse through all versions for any given backup job, sorted by date,
and enables them to restore (rollback) all or some of their files to the state they were in, at the point in time
that backup was executed.

Users can also limit the number of backup versions Genie Mail Backup should keep per backup job, in order
to preserve disk space. This is done by configuring Purging settings.
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Security in Genie Mail Backup

Genie Mail Backup offers multiple levels of protection to ensure that backed up data is not accessible to
unauthorized persons. ZIP passwords offer moderate protection for compressed backups, with the added
flexibility of being compatible with most compression utilities, to allow users to manually restore data from
backup archives, while AES (Advanced Encryption Standard) encryption has the advantage of being highly
secure, as it is adopted by NIST(National Institute of Standards and Technology) as an FIPS-approved
(Federal Information Processing Standard) symmetric encryption algorithm that may be used by U.S.
Government organizations (and others) to protect sensitive information

Our online backup solutions enjoy an added level of protection, through username and password encryption,
as well as 128- bit Secure Socket Layer (SSL) data transmission, certified by the leading global provider of
SSL certificates, Thawte.
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Compression in Genie Mail Backup

Genie Mail Backup uses non-proprietary ZIP64 compatible compression to reduce backed up data size and
save space, supporting up to 264 -1 files within a zip archive as well as files that have a size greater than
4GB, for a zip file size that can reach up to about 18 million terabytes (more precisely,  2^64-1 bytes).

The Genie Mail Backup compression engine offers fast performance and low memory usage. Speed
improvements reach 25%-75% in certain contexts. It also provides 15 to 20% better compression than
other formats on many popular file types, especially XML data.

Users can choose between 9 levels of compression starting from no-compression, which packs the entire
backup neatly within a single file, but without the overhead to the backup speed added by compression.

 

Backup without Compression

Choosing to backup data without compression causes GMB to copy the data to a single folder on the storage
device while preserving the original folder tree structure, this makes data more accessible and less
susceptible to corruption.
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Files Created by GMB Locally

Genie Mail Backup creates a variety of temporary and permanent files and folders on the machine on which
its running during its various operations that are either intended to be used by the user or for the program's
internal use.

 

Job-related files and folders

When a new backup job is configured, the wizard creates a "JobSettings.dat" file in a folder carrying the
same name as the backup job (usually in C:\Documents and Settings\<user>\Application Data\Genie-
Soft\GMBAPPLICATION).

In addition, GMB also creates subfolders in the same location for each backup execution starting with a
folder named "00000000" for the first backup run, and a new folder with the name incremented by one for
each subsequent execution. Each folder contains catalog information for the corresponding backup run.

 

Temporary folders

Genie Mail Backup creates a temporary folder at the start of each session to store transient files and folders
that are created during the program's operations, such as data waiting to be written to CD or DVD, or data
being encrypted or compressed etc.

Temporary session folder will be deleted when the session is closed (upon exiting main application).

Unless otherwise specified by the user, GMB will look for the local drive with the most free disk space
and select it for storing its temporary folders and files.

Temporary files created during a backup run will be deleted when backup is complete.

 

Logs

Genie Mail Backup provides a log engine that helps you track backup, restore and test operations. It also
offers advanced logs for tracking and debugging backup operations and volume shadow copy snapshots. For
more information on each of these logs and how to access them, please refer to the Logs and Reports
section.
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Files Created on the Backup Destination

This is a list of the most important files that Genie Mail Backup might create on the backup destination,
along with a description of what each folder/file type signifies:

 

.gbp

The .gbp file type is associated in Windows with Genie Mail Backup, and it represents the file that the user
needs to select in order to load the backup for restore. This file is recreated at each backup execution. When
backup is executed with compression enabled, the file with the extension ".gbp" will represent the main
backup output file containing the entire backup archive along with GMB's internal use files. If data was forced
to split, such as in the case of multiple media spanning, this will be the last file in the set.

In case of backup with compression disabled, GMB will create a file called Main.gbp in the uncompressed
backup folder at each backup execution, which will only serve as a link to the index.gix catalog file, located
in the same folder, that holds the necessary information for restoring the data from the backup archive.

 

.c00<X>

This file type represents a split in a compressed backup archive; this occurs when a single compressed
archive is divided into multiple linked portions, sequentially numbered starting with .c000 to c00X, where X

is the number of split compressed file parts. The last file in the set is always the file {backup job
name}.gbp.

 

.n00<x>

This extension represents a source file that has been split during a backup execution with compression
disabled.

 

.exe

This file is created when the Self-Restorable backup option is selected in the backup job's configuration. If
this file is present, Genie Mail Backup does not need to be installed on the target machine in order to restore
data from the archive.

If compression was enabled, this file will contain the entire backup archive as long as the size of the data in
its compressed form is less than the number specified for the Enable one-file self-restorable backups
option; however if this size limit was exceeded, or if the backup was uncompressed, Genie Mail Backup will
create a file called "Swift_restore.exe", which will only contain a self-executable version of the restore
functionality.
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How to: Start Genie Mail Backup

Before you start, make sure that your backup devices have been detected and are configured correctly
without conflicts.

To start Genie Mail Backup...

Click Start , point to Programs > Genie-Soft, and then click Genie Mail Backup 8.0.

If you have selected the option to add an icon to your Quick Launch bar when you installed the
software, you can click that icon to start Genie Mail Backup.
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The Welcome Screen

The welcome screen is the first window that opens when the user runs GMB. This window contains links to
tutorials and helpful information and tips for using Genie Mail Backup.

To open the welcome screen at any time click Help in the toolbar then select Welcome Screen. To
suppress the welcome screen remove the checkmark next to Show welcome screen at startup.
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The Grand Tour

If you are a first time user of Genie Mail Backup, it is recommended that you watch the backup tutorial to
become familiar with the software and its interface. The tutorial will simulate the creation of a backup job
and guide you through the backup wizard screens. Other tutorials are available and can be accessed from
the Welcome screen.

To view the Genie Mail Backup flash tutorial select Take a Tour from the applications main window.

 

Failing to View the Tutorial

If the tutorial fails to play, you might need to install the latest version of the Macromedia Flash Player. You
can download the latest version of Flash Player from the Macromedia website by clicking the link below:

http://www.macromedia.com/shockwave/download/download.cgi?P1_Prod_Version=ShockwaveFlash
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Shortcuts

The most important functions in GMB are assigned keyboard shortcuts for increased accessibility.

Backup Wizard Shortcuts

Main Window Shortcuts

Miscellaneous Shortcuts

Copyright (c) 2007 Genie-Soft, Inc. All rights reserved.



Selection Panes

Selecting data for backup or restore in GMB is done using a Windows-Explorer-like interface. Selection panes
are used to select or deselect files, folders, and various items and settings.

When an item from the left pane is highlighted its contents will be displayed in the right pane, to refine the
selection if necessary.

A plus sign means that the listing can be expanded to display additional items.

A minus sign means that the listing can be collapsed to hide displayed items beneath it.

An empty check box means that the item can be selected but is currently not.

A check box with a blue or green check mark means that the item is selected with all its
contents.

A gray check mark means that some but not all of the item's contents have been selected.

A grayed out check box means that the item is not available or not selectable; if the item has an
Expand/Collapse box then the user needs to expand the listing to be able to select its contents.
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Accessibility

Microsoft Windows offers "Accessibility Options" that make it more eye-friendly for people with visual
disabilities. They allow you to modify the display to make it easier to work with the computer.

GMB supports visual accessibility options; changing Windows appearance will change GMB's user interface
making the software more readable for people with color blindness, weak vision etc...

GMB needs to be restarted before changes in visual accessibility options are applied.
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Windows and Dialogs

Most windows and dialogs in Genie Mail Backup can be resized to fit the users preference. The minimum
dimensions for the main window is 740X570, hence it is recommended to set the display resolution to
800X600 or more in order to be able to see the entire contents of any window.

When a pane or window is not resizable and part of its contents is hidden, scroll bars will appear enabling
the user to view the concealed parts.

GMB by default remembers the location and size of the main window upon exiting the application so that
these attributes would be retained the next time GMB is started. To disable this feature, click the Tools
menu command, select Global Preferences, select General, then remove the checkmark next to Save
window location on exit.
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Job Summary

During the creation or modification of a backup job, the lower-left corner of the backup wizard will provide a
summary of the backup job's settings, this include:

Job name: Name assigned to the backup job.

Media Type: Media selected for storing the backup.

Backup Type: Full or increment (backup all selected files or new and changed files).

Compression: Compression setting (with or without compression).

Security Type: Type of security setting used (None, zip password protection or encryption).

Estimated size: The total estimated size of selected items.  

Estimated items: The estimated number of files selected for backup.
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Wizards Overview

GMB adopts wizard-like interfaces for its three main functions: Backup and Restore. Each of these will be
described in details later on.

Each wizard is comprised of a series of dialog boxes guiding the user through the steps required to perform
the task, all the user has to do is choose the appropriate options in each dialog and then click Next to
proceed to the following step. At any point, the user can click the Previous button to correct or modify
selections made in previous dialogs.
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Getting Help

GMB users can seek assistance regarding the use of the various functions and features of the software using
several different help resources, which include:

Offline Help

Online Technical Support

The Knowledge Base

Community Forums
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Exiting GMB

To exit GMB do one of the following:

From the File menu in the toolbar select Exit.

Press <ALT + F4>.

Click the X button on the top right corner of the program.

Attempting to exit will open a dialog asking the user to confirm the request

 

Suppressing the quit confirmation dialog

Registered users can suppress the quit confirmation dialog, to do so:

From the toolbar, select Tools, then select Global Preferences.1.

Select General.2.

Remove the checkmark next to Confirm quit dialog box.3.
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How to?

Genie Mail Backup

How to: Install Genie Mail Backup

How to: Register Your Copy of GMB

How to: Check for updates

How to: Start Genie Mail Backup

Open File Backup Agent

How to: Install Open File Backup Agent

How to: Register Open File Backup Agent

Catalog

How to: Back up the Catalog

Local/LAN

How to: Restore from a Local Drives

How to: Enable OFB Agent to Backup Open Files on Remote Locations

FTP

How to: Restore Data Backed Up Using FTP

Online Backup

How to: Restore/View Online Backups

How to: Restore from Genie Drive

How to: Purchase Extra Online Space

How to: Delete Online backups

Optical Media

How to: Restore from Optical Media

Removable Media

How to: Restore from Removable Media

Outlook

How to: Backup MS Outlook Data



How to: Restore Outlook Data

Outlook Express

How to: Backup Outlook Express

How to: Restore Outlook Express Data

How to: Synchronize Outlook Express Mail Folders

How to: Synchronize Outlook Express Settings

How to: Extract mail folders directly from a backup

How to: View Backed Up Emails

Windows Mail

How to: Backup Windows Mail Data

How to: Restore Windows Mail Data

Windows Address Book

How to: Back Up Windows Address Book

How to: Restore Windows Address book

How to: Synchronize Windows Address Book Contacts

Windows Contacts

How to: Backup Windows Contacts

How to: Restore Windows Contacts

Windows Favorites

How to: Back Up Windows Favorites

How to: Restore Windows Favorites

Internet Explorer

How to: Backup Internet Explorer

How to: Restore Internet Explorer Settings

Windows Settings

How to: Back Up Windows Settings

How to: Restore Windows Settings

My Files



How to: Backup My Files

How to: Restore My files

Settings

How to: Create a Quick-Backup Shortcuts on the Desktop

How to: Create Self-Restorable Backups

Restore

How to: Load Backup from the Archive

How to: Load Backup from the Catalog

How to: Restore Using SwiftRestore

How to: Restore Data

E-mail Notification

How to: Activate E-mail Notification

How to: Send Email Notifications
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Main Window Commands

The main window contains a selection of the most important Genie Mail Backup functions.

 

Main Commands

Starts the new backup wizard.

Starts the restore wizard.

 

Starts the catalog.

Opens a list of available backup jobs which the user can choose from to edit a backup job's
configuration.

Enables you to View/Restore and Manage your online account

 

Switch to Easy Layout

 

Tools

- Opens a list of available backup jobs which the user can from to quickly execute a
backup.



- Opens Genie Mail Backup's preferences dialog.

- Opens the Test Data Integrity window.

- Opens the GMB automatic update window.

- Opens a flash-based walk-through for configuring a new backup job in Genie Mail
Backup.

 

Quick Links

- Direct link for purchasing GMB online.

-Direct link to My Account for online registered users

- Opens the Backup encyclopedia.

- Register your copy of GMB online.

- Contact information for the Genie-Soft technical support team.

- Opens the Genie-Soft home page in your default Internet browser.

 

Menu Commands

Menu Item Function

     

File Backup Wizard Open the backup wizard.

  Online Restore Wizard Restore backups stored on the Genie-Soft online backup
server

  Restore Wizard Open the restore wizard.

  Cataloging Open the backup Catalog library.

  Default Backup Folder Browse the default location used by GMB for storing
backups.

     



Tools Test Backup Test a backup set's data integrity to ensure it can be
restored reliably.

  Advanced Search Search the catalog library or a backup archive for
previously backed up files.

  Jobs Manager Open the backup jobs manager window.

  Online Login Open a dialog to enter your Genie-Soft's online backup
credentials

  Extract Archive from .exe
File

Extract a backup set from a self-restorable backup.

  Format Re-Writable
CD/DVD

Quick-erase or fully format CD/DVD media.

  Global Preferences Open the Global Preferences window to edit general and
advanced Genie Mail Backup settings.

     

Help Contents Open the Genie Mail Backup help documentation.

  Backup Encyclopedia Open Genie-Soft's free Backup Encyclopedia project web
site.

  Welcome Screen Open the welcome screen.

  Supported Recorders  

  Genie-Soft Home Page Opens your default internet browser to the Genie-Soft web
site.

  Check for Updates  

  Registration Open the Genie Mail Backup registration dialog to enter
your serial number and unlock the software.

  Register OFB Plugin Open a dialog to insert your Open File Backup agent serial
key.

  How to register Open help page on how to register your copy of GMB.

  Technical Support -
Contact Us

Contact information for getting in touch with Genie-Soft
support team to receive technical assistance.

  About Credits and basic information about the product.

To access a program menu item using the keyboard

Press <ALT>. This will highlight the File menu in the toolbar.1.

Use the right and left arrow keys to move horizontally between menus and the up and down arrow2.

3.



1.

keys to move between items inside each menu.
2.

Press <ENTER> to activate the selection.3.

 

Backup Summary

The backup summary panel displays a summary report for the most recently performed backup. It also offers
quick access links for viewing the complete backup report as well as re-running the backup.
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The Backup Wizard

Users can create backup jobs in Genie Mail Backup using one of two different wizard layouts:

Easy mode: A 3-step simple wizard. Advanced backup settings are set to default.

Normal Mode: A 5-step wizard that gives users more control over the backup job and its settings.

Changing the Backup Wizard Layout

To switch from one backup wizard layout to another:

From the main screen, click the Switch to Easy Mode or Switch to Normal Mode button in the lower-right
corner of the screen.

Opening the Backup Wizard

From the startup screen click the Backup button.

From the Files menu, select Backup Wizard.

 

For each backup job you must specify at least the source files, folders, or other data items that you want to
backup (third wizard step), the rest of the options are not mandatory as they are set to default values, but
can be changed by the user.

The user can move between the wizard screens using one of the following ways:

Clicking the Next button in the lower right corner, to go through all the wizard screens one at a time.
Clicking the Previous button takes the user one step back.

By choosing the desired wizard screen from the Backup Steps menu on the left side of the screen.
This allows the user to skip steps that have been set before.

Features not available in Easy Mode

Backup to Removable, CD/DVD, FTP, and Online

Creating more than one backup job

Timestamp

Encryption

Backup without compression

Self Restorable backup

Incremental



Purge settings

Cataloging

Email notification

 

 

 

 

 

 

 

Copyright (c) 2007 Genie-Soft, Inc. All rights reserved.



The Restore Wizard

Using the Restore Wizard you can restore from a backup job. The restore wizard consists of two steps
(pages), from which users can configure what and how to restore. To open the restore wizard select  click
the Restore button from the main window, or select the Files menu, then select Restore Wizard.

These are the steps that you must confirm in the restore wizard:

Select a file to restore (loading the backup): Select the backup archive you wish to restore data
from. Depending on the destination on which the backup is stored, select one of the following options
from the left menu:

Select Backup Set: For selecting and loading a backup stored on disk-based media, or more
generally, any backup destination other than Genie-Soft's online backup servers. See the Restore
section.

1.

Data Selection: Select the files and folders you wish restore via My Mail. Click Next to start restore.2.
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Online Backup Account

From this page users can manage the whole online backup account. Login to My Account enables users to
connect to their online account and view the backed up jobs. Select a backup job or Genie drive and click
Restore/View to view the contents of the backed up or uploaded data to Genie Drive. Create Backup Job
opens the online backup wizard to create a new online backup Job.

If the Online Account is running out of space, you can Delete Selected Job, Delete all Jobs, or upgrade
your online plan from Need more space link.

Under Web Online Account Management, you can Manage My Workspace, which opens the online
backup web service. This Workspace enables you to create, edit, and view documents directly from the web
account, opens thumbnails of images and much more! For more information, please visit your online account
via web.

     



Global Preferences

The Preferences window houses the settings, preferences and configurations for GMB.

To open the Preferences window, do one of the following:

From the toolbar click Tools, then select Global Preferences.

From the Tools left-hand menu in the main screen, select Global Preferences.

 

Note: Settings selected from the preferences dialog will apply to all created backup jobs.
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Preferences: General

The General page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains general settings of the program.

 

Select the frequency at which GMB should automatically check for software updates. (This option is only
available for registered users).  (Settings)

 

 

Causes GMB to prompt the user to confirm before closing the main application. This option is only available
for registered users.

 

Associate the extension ( .gbp) with Genie Mail Backup in Windows; clicking a file with ".gbp" extension will
automatically load the backup and open the restore wizard within Genie Mail Backup.

 

Remember the size and location of the GMB main window the next time it is run.

 

Specify a local folder for storing temporary files created by GMB during its various operations, See Files
Created by GMB Locally.  (Settings)
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Preferences: General - Advanced

The Advanced page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains advanced settings for the program.

 

Enable advanced logging. Used for trouble shooting purposes by the Genie-Soft technical support team.

 

Open the folder containing Genie Mail Backup's advanced debugging logs.
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Preferences: General - Sound Alerts

The Sound Alerts page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains settings related to attaching sounds to various events in the program.

 

Enable associating sounds with Genie Mail Backup events.

 

List of GMB events that the user can add sound alerts to.

 

Enable sound alert for the selected event.

 

Browse your computer to select a sound file to be associated with the selected event.

 

Preview selected sound file.
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Preferences: Backup Settings

The Backup Settings page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains settings related to backup operations.

 

Automatically display the backup activity log after each backup run.

 

Automatically display summary of results after each backup run.

 

After GMB confirms selections, wait X seconds before starting backup.

 

The default folder used for storing backups when a new backup job is created.
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Preferences: Backup Settings - Advanced Settings

The Advanced Backup Settings page of the Global Preferences window (accessible from the Tools
menu, Global Preferences menu item) contains advanced backup-related settings.

When self-restorable backup sets is enabled with compression and the size of the data after compression is
less than the amount specified, the entire backup set will be contained within a self-executable file (.exe).
Otherwise, the self executable file will be copied as a separate file on the backup destination.

 

When a filename is in unicode, rename the file using a unique GUID, to avoid problems restoring the data on
platforms that do not support unicode character sets. GMB will rename the file to its original name upon
restore.

Let GMB to decide whether backing up to a temp location is necessary or not.
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Global Preferences: CD/DVD Settings

The CD/DVD Settings page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains options pertaining to writing to optical media.

 

Select this option if you want to use filenames that contain up to 64 characters in length, including spaces.
This is the default option and is used to record most CDs/DVDs. Joliet also records the associated DOS-
standard name (8+3 characters) for each file so that the disk may be read on DOS systems or earlier
versions of Windows.

Juliet must be used if you want to use file names that contain up to 64 characters in length, including
spaces. Joliet also records the associated DOS-standard name (8+3 characters) for each file so that the CD
may be read on DOS systems or earlier versions of Windows.

ISO9660 is used if you want to be able to read the CD on different platforms including DOS, Macintosh,
OS/2, Windows and UNIX. Files and directories recorded to CD based on the ISO 9660 standard must meet
the following (8+3) requirements:

A file name may not contain more than eight alphanumeric characters and the underscore symbol [_].

A file name extension may not contain more than three alphanumeric characters.

A directory name may not contain more than eight alphanumeric characters and the underscore symbol
[_].

Although using ISO is supported in GMB it is strongly recommended that the user uses Joliet to avoid
running into file/folder naming compatibility problems. Otherwise, the user must manually make sure that
the naming convention of all selected files and folders are compatible with the ISO9660 standard.

 

This option increases the reliability of backup to CD media by creating a temporary file on the hard disc that
is then written at once to disc. Caching, however, means that GMB will first copy the data to a temporary
local drive and then onto the CD, which adds a few minutes to the total running time for each disc.

Caching is not supported on DVD.

If GMB doesn't detect enough space to perform caching, data will be copied directly to the CD.

 

Close the CD/DVD media so that further writing to it is not possible. This is done by not recording the next
writable address in the last session's lead-in, so that in the next time the recorder attempts to write, it has
no way of knowing where to begin writing. Only finalize CDs if you are sure that you will not be appending
new backup versions to it.

 



This technology helps prevent bad burns and CD/DVD creation errors, including buffer underrun and
trackwriter errors. This option might not be supported by all CD/DVD drives.

A Buffer Underrun occurs when the PC cannot deliver data fast enough to the drive's buffer. If the drive's
buffer empties because of the lack of data, the laser will turn off. The resulting gap on the media usually
renders a CD-R disc unusable"

The BURN-Proof feature is effective only for Buffer Under Run errors. Therefore this feature does not cover
the following cases

Power outage or power disconnection.

Malfunction or abnormality in PC / Application software.

Impact on the drives or inferior condition of the media.

 

If the CD contains more than one session, the most recent session is automatically imported so that it could
be updated with the new data.  

Each time data is written to a CD/DVD disk a table of contents is written at the end of the session in order to
make the disk readable. This procedure is called session closing; data can still be appended to the disk after
a session is closed.

Genie Mail Backup will by default import previous sessions on the inserted disc before writing to it so as not
to lose existing data.

Disabling this feature causes GMB to write a new table of contents that does not refer to previously written
data on the disc, rendering that data hidden and inaccessible, but it will not free the space occupied by it.

If a file with the same name as the backup file already exists on the CD, GMB will rename the new file by
appending a trailing number, that is incremented by one for each new version of the file that is added.

 

This option prevents accidental overwriting of previous backup jobs stored on the CD/DVD in case a file with
a similar file name already exists on it.

 

When backup to optical media is performed, eject the last disk in the media set to alert user that backup is
finished.
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Global Preferences: Online Backup

The Online Backup page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains options related to the online backup functionality.

This option enables you to limit the bandwidth used to upload to Genie Servers

Maximum upload rate GMB can use to upload backed up files to Genie Servers

 Always limit maximum upload rate

Limit maximum upload rate between these hours; otherwise, use full bandwidth

 

If this option is disabled Genie Mail Backup will cache the entire backup set to file in a temporary local
location, and then upload it to the Genie-Soft Online Backup Servers. Otherwise, GMB will cache and upload
chunks of data according to the size limit specified in the option below.  

 

Set the size for local temporary cache created before uploading data. Make sure your hard drive has enough
disk space for the cache file to be created.  
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Preferences: OFB

The Open File Backup page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains options related to handling open files during backups.

 

Allow Volume Shadow Copy service to copy open files during backups.

 

Allow Open File Backup Agent to copy open files during backups.

 

Run Open File Backup Agent as a process in the background.  

 

Stop Open file Backup Agent. It is recommended to always keep OFB running to ensure a skipped-files-free
backups.

 

Displays the status of Open File Backup Agent: (Activated, Paused or Not installed).

 

The version of Open File Backup Agent currently installed on the computer.
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Preferences: Restore Settings

The Restore Settings page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains settings related to restore operations.

 

Automatically open the restore log after each restore job.

 

Remember each backed up file's attributes (hidden, read-only, system, archived) and modified date and time
stamp, to insure they are retained when files are restored.

 

Settings to be used when restoring Microsoft Outlook data.  (Settings)
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Preferences: Testing Data Integrity

The Testing Data Integrity page of the Global Preferences window (accessible from the Tools menu,
Global Preferences menu item) contains settings defining how Genie Mail Backup verifies the reliability of
produced archives after backup.

 

Run data integrity test automatically after backup is complete.

 

Prompt me for action after backup is finished.

 

Do not perform data integrity testing after backup.

 

When performing incremental backups, verify only files that have been newly appended to the backup set.
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Preferences: Email Notification Settings

The Email Notification page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains the mail server settings GMB uses for sending notifications of performed
backups via email.

 

SMTP server hostname or IP address.

 

SMTP port number. Default value is 25.

 

SSL (Secure Sockets Layer) is a security protocol that provides communication privacy. Select this option if
your SMTP server supports SSL.  

 

Email address to appear in the sender (From) line.  

 

Email address of the recipient of the notification.  

 

Text to appear in the Subject line of the notification email

 

Select this option to include the backup log with every notification email.

 



Open a dialog for configuring advanced email sending options.  (Controls)

 

Send dummy notification email to test the entered settings
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Global Preferences: Auto-Exclude

The Auto-Exclude page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains settings for automatically ignoring specific files and folders during backup.

Some system files and folders on the computer are not made to be moved or copied, and are accessed only
by the Windows system, trying to backup these files will cause an error in GMB. To avoid running into backup
problems, GMB by default skips these files and folders in all the backup jobs created by the user. This
preferences window enables the user to add/remove files and folders from the 'Auto-Exclude' list.

 

Automatically exclude the files and folders specified in the list whenever a backup is performed.  

 

List of files and folders to be automatically excluded from all backup jobs.  

 

Remove an item form the list.

 

Add an item to the auto-exclude list.  
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Preferences: Cataloging

The Cataloging page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains settings related to the cataloging feature of the program.

 

Allow GMB to create a library containing history of backup jobs/runs.

 

Enable user to choose a backup set from the catalog and open it within the restore wizard, to browse
and select files for restore, even if the media set is still not loaded.  

 

Allow GMB to do an incremental backup run by referring to the backup job index saved in the catalog,
instead of the one on the storage media. This is needed when the user is trying to store the data from
a new backup run on a new media volume, other than the one containing the data from the previous
run.
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The Catalog

The Catalog is a library containing a list of all defined backup jobs and the files backed up during each job's
executions. With this utility, users can keep track of file versions, and run, view search for and extract files
directly from the backup archive without going through the restore wizard.

For each new execution of a backup job, Genie Mail Backup creates a new subfolder in a folder carrying the
same name as the backup job (usually in C:\Documents and Settings\<user>\Application Data\Genie-
Soft\GMBAPPLICATION\), starting with a folder named "00000000" for the first backup execution, and a new
folder with the name incremented by one for each subsequent run. Each folder contains catalog information
for the corresponding backup execution, which Genie Mail Backup refers to, to populate the catalog window.

To access the catalog click the Catalog button in the main window, press <Alt+C>, or select Catalog from
the File menu.

Although highly not recommended, users can disable cataloging if they feel that they will not be benefiting
from this feature, and wish to spare the small amount of disk space that would otherwise be consumed by
the catalog files. This can be done by clicking the Tools menu, selecting Global Preferences, selecting
Cataloging, and unchecking the box next to Enable cataloging. Note that doing so will prevent Genie Mail
Backup from writing catalog information locally, thus loosing all historical data related to backup executions,
and the ability to browse, search, extract, view, or run backed up files, unless restored first.

 

Using the Catalog

Backup jobs are listed in alphabetical order in the left pane of the catalog window. Expanding the tree
beneath a backup job displays its versions ordered according to the date and time on which they were
executed. Users can expand the tree under any backup version to view detailed information about the files
that were backed up. The following filters can be selected: All files, New files, Unchanged files, Modified
files, and Deleted files. Clicking on one of the filters displays the results in the right pane. The following
columns are available in the file list view, which can also be used for sorting:

Filename: name of listed file.  

Size: size of listed file -before compression if backup set was compressed-

Date Modified date of the most recent change made to the file before it was backed up.  

GMB Data Type:  My Mail

Extension: the filename extension (file type) of the backed up file.

Original Path:  the original path in which the backed up files was located.

 

The user can further refine the list of results by typing a filename mask in the Filter by field above the
results pane. For more advanced file searching options, see Advanced Search.

 

Right-Click Options



Right clicking an object from the panes in the Genie Mail Backup Catalog will open a menu with options
related to the clicked item.

Right-Clicking a Backup Job:

Delete Job: Delete all catalog entries for the currently selected job.  

Expand All: Fully expand the tree beneath the selected backup job.  

Collapse All: Collapse the tree of backup runs below the selected backup job.  

Right-Clicking a Backup Run:

Restore: open the restore wizard to restore data from the selected backup run.  

Show log: Show backup log for the selected backup run.  

Delete: Delete the catalog entry for the selected backup run.  

Delete All: Delete all catalog entries for the currently selected job.

Right-Clicking a File:

Restore selected file: Extract the selected file to a location specified by the user.  

Restore checked files: Restore all files with ticked checkboxes to a location specified by the user.  

Mark all: Mark all files as selected.

Clear all: Deselect all files.  

Run selected file: Open selected file using the application associated by Windows with its file type.  

View with Notepad: View selected file using Notepad.  
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Advanced Search

The file Search dialog offers the most direct way to locate a backed up file. Use the Search dialog if you are
looking for common file types, if you remember all or part of the name of the file you want to find, If you
recall the size of the file you wish to locate, or if you know when you last changed a file. The Search dialog
can search within all performed backup runs to locate all revisions of a file or files.

To open the advanced search dialog from the catalog window, click the Advanced Search link the upper-
right corner.

You can write the name of the file you wish to locate directly in the Search for field. If you know only part of
the name, you can use wildcard characters to locate all files that include that part in the name. For example,
*map.* will find "road map.jpg", "tech map.doc", and "tech map.txt". You can also search for files which
names contain a sequence of adjacent letters. For example, ost will find "most wanted.doc", "host.txt", and
"outlook.ost".

You can instruct Genie Mail Backup to look for your file either in a specific backup archive, or in all the
archives created by currently configured backup jobs, by selecting one of the following options from the
Search in drop-down menu.

Selected Backup Run: Search for file within the highlighted backup run.

Selected Backup Job: Search for file within the selected backup job.

All Jobs: Search the entire catalog.

Browse for Backup Job: Open a list of backup jobs/runs to choose from

Browse for Backup File: Specify a backup set to search within, useful when there is no catalog entry
is available for that backup set.

The GMB data type menu enables you to refine your search by specifying whether the file you are searching
for belongs to a My Mail item.

You can use additional search criteria to make your search more specific by clicking the More choices tab,
this will enable you to refine your search according to the size and/or "last modified date and time" attribute
of the file(s) you are looking for.
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How to: Back up the Catalog

The catalog is normally small enough to fit on one floppy disk depending on the total number of files listed in
the catalog.

To backup the catalog

From the left navigation menu in the backup wizard select What to Backup.1.

Select My Plugins tab.2.

Select GMB 8.0 Preferences, Jobs, Scripts and Catalogs.3.
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Backup Devices

The Where to Backup wizard screen defines where the backup will be stored. To choose a storage device
during backup job creation/editing select Where to backup from the left navigation menu in the backup
wizard. Make sure you can write in the destination and the selected folder (you have the proper rights and
the media is not write-protected).

GMB is the only backup software that grants users the flexibility of choosing between all the following
storage destinations without the need for purchasing and installing extra plugins or add-ons:

External and Internal hard disks.

Across network (Shared network locations, SAN devices, NAS devices, etc.).

Memory Sticks (Flash memory).

CD/DVD media (all formats - DVD±RW/DVD±R/DVD-RAM/CD-R/CD-RW), including Blu-ray.

Removable media devices (REV, floppy disks, ZIP disks, JAZ etc ...)

Remote locations using FTP service.

Online backup

For each backup run, a new index (".gbp file") is created in the destination folder, containing the backup
job's catalog as well as other information necessary for Genie Mail Backup to be able to restore data
automatically. If this file is lost, GMB will not be able to restore data, and the user will only be able to
manually access the files and folders stored in the archive. The catalog is also stored locally to enable offline
browsing of the data stored in the backup (even if the storage media is not loaded), as well as file versioning
information.

If the backup destination drive/device is missing or disconnected when backup starts, Genie Mail Backup will
display a warning message saying that there is not enough space on the destination, and backup will be
aborted.

Note:

In easy mode, backing up to Local/LAN is only supported
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Internal and External Drives

Genie Mail Backup allows users to backup data to hard disk drives of all kinds, whether internal or external
(hard drives, USB drives etc.). In addition, GMB enables users to select more than one hard disk as a backup
destination; if one hard disk gets full, GMB will automatically continue backup to the next hard disk specified
in the multi-drive spanning list. The Local/LAN option is selected by default when you define a new backup
job, and data is backed up to the default backup destination as specified in the Global Preferences
window.

To backup to an internal or external hard drive during backup job creation or editing, select Where to
Backup from the left-hand menu, then select Local/LAN location.

Note:

You can also backup USB attached external drives using Removable media option as it is automatically
detected.
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Splitting Backup Files

Using the new 64-bit Zip compression, Genie Mail Backup compresses backed up data to one file that can
reach up to about 18 million terabytes in size ( more precisely,  264 -1 bytes) - provided that this is
supported by the file system being used - However, the user might want to split the compressed backup file
into multiple smaller chunks, for instance in order to copy them later to removable media, or when the file
system, such as FAT 16, does not allow creation of large files etc.

GMB can split the backup set into multiple linked files with sequentially numbered extensions (e.g. .001 .002
.003 etc ...) with the last file in the series assigned the main (.gbp) extension.

 

To split backup files:

From the left navigation menu in the backup wizard select Where to Backup.1.

Select Local/LAN Location.2.

Select Enable multi-drive spanning.3.

Select Use fixed split size, then enter the desired split size value.4.
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How to: Restore from a Local Drives

Restoring data from backups stored on local hard drives is straight forward.

Make sure that the drive on which your backup is stored is attached to the computer and accessible
from Windows Explorer.

1.

Open the folder holding the backup on your device.2.

Double click the main "gbp" file corresponding to the backup set you wish to restore data from.3.
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Backup to Network Locations

Genie Mail Backup allows backing data to LAN-connected devices (Local Area Networks), these include
shared network folders, mapped networked drives, SAN devices, NAS devices etc...

To backup to a networked device or location during backup job creation or editing, select Where to Backup
from the left-hand menu, select Local/LAN location, click Browse, then select My Network Places or
type the full path to the backup destination.
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How to: Enable OFB Agent to Backup Open Files on Remote
Locations

Open File Backup Agent can be set to handle open files while backing up data using Genie Mail Backup from
a network-connected machine. This allows centralized LAN-based backups for clients with potentially-open
files.

Perform the following steps on each network computer you intend to backup data from:

Install Open File Backup Agent.1.

Click Start, point to Genie-Soft, then Genie Mail Backup 8.0 Tools, and click OFB.2.

Right-click the Genie Agent icon in the system tray then select Settings.3.

Make sure Allow Network Access to This Computer is selected.4.
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FTP Servers

Genie Mail Backup allows users to perform backup operations to any FTP server connected to the Internet by
simply entering the server's address and authentication. Genie Mail Backup will create a local temporary
copy of the backup, then "push" a data stream that can be compressed and/or encrypted to the designated
FTP server. This feature will allow you to easily store data offsite or perform centralized backups for remote
client data.

To perform FTP backup, select Remote Location Using FTP from the Where to Backup page in the
backup wizard. Available space on FTP server will not be calculated/displayed during backup. You will need to
make sure the FTP account you are using has enough disk space.

When backing up to a remote machine using FTP, GMB first creates a temporary copy of the backup locally
on the machine then uploads it to the FTP server, these files are by default deleted immediately when
backup to FTP is complete. The user can set GMB to keep these files even after backup is done - to serve as
a local second copy of the backup- from the Advanced Settings dialog.

If the connection is dropped or interrupted, or if there was no upload activity for a considerable period of
time during backup to a remote FTP server, GMB will pause the upload and retry to reestablish connection (if
possible) then resume from the broken point; GMB repeats these steps until the entire backup is uploaded or
the number of retries specified by the user are exceeded. Users can modify the number of auto-resume
retries from the Advanced Settings dialog.

Users can restrict the transfer rate at which GMB uploads data to the FTP server during backup, so as not to
"hog" the connection's bandwidth from the Advanced Settings dialog.

 

Limitations of FTP Backup

When FTP backup is selected, the following GMB features are not supported.

Purging old backup files.

Incremental backup without rollback.

Extracting from Catalog
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FTP Backup Settings

The FTP backup settings dialog allows access to advanced FTP connection settings that users can customize
for optimized performance and compatibility with the FTP server.

To open the advanced FTP Backup settings dialog, select Where to Backup from within the backup wizard,
select Remote location using FTP, then click Advanced Settings.

 

Name or IP address of FTP server.

 

FTP server port number. Default value is 21.

 

Username for the FTP access account.

 

FTP access account password.

 

Path to which the backup should be stored on the server. If path does not exist, GMB will create it.

 

Perform a test connection to the server, to check that the entered settings are correct.

 

Advanced FTP connection settings. (Controls)
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How to: Restore Data Backed Up Using FTP

GMB currently does not support direct data restore from FTP sites. In order to restore FTP backed up data,
the user needs to first download the backup files from the FTP server using either an Internet browser, or a
third party FTP software.  It is recommended to use third party FTP software to download the backup set for
better reliability and speed.

 

Restoring from FTP Using the Default Internet Browser

Open your default Internet browser.1.

Login to the FTP site containing your backed up data by entering its URL into the address bar in the
following format:

ftp://[username]:[password]@[ftpsiteaddress]

Where:

2.

[username] is the username of the FTP account used for uploading files.

[password] is the password for the FTP account used for uploading files.

[ftpsiteaddress] is the address for the FTP site used for uploading files, including the complete
path to the location of the backup set.

E.g.

ftp://sam:mypassword@my.ftp.site.com/genie/monday/

Locate the backup set and then Copy/Paste it onto your hard disk.3.

Follow the local restore procedure.4.

 

Restoring from FTP Using Third Party Software

Use a third-party FTP software to download the complete backup set onto your hard disk.1.

Follow the local restore procedure.2.
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Online Backup

Online backup is Genie-Soft's latest offering for users who wish to safeguard their data, without the hassle of
maintaining shelves of stacked backup disks or cartridges. Online backup with GMB is as easy as backing up
to any local hard drive, ensures around-the-hour worldwide data accessibility, and is highly secure, through
username and password encryption, as well as 128- bit Secure Socket Layer (SSL) data transmission,
certified by the leading global provider of SSL certificates, Thawte.

You can sign up to get a free-of-charge trial account to test our unparalleled online backup service by
clicking the Sign up for a free trial account link. The trial account will grant you 50MB of free online

backup space. Credit card information will be requested, but your card will not be charged.

Your Genie-Soft online-backup account also offers Genie Drive feature, which enables uploading personal
files via email, organize your data by creating new folders, deleting, cutting, copying, and pasting files and
folders to different locations in the Drive. In addition to that, Genie Drive allows you to easily share folders
with friends and family or cooperate workgroups. You can drag-drop files and folders to the drive that is
installed on your computer and it will automatically synchronize with the web service. For more features,
login to your online account via web.  

Finally, using Genie Online-Backup, you can set multiple users and allocate disk space quota for each one.

Setting Genie Mail Backup to perform online backup:

Make sure you have an online backup account with enough free space.1.

From the backup wizard, select Where to Backup.2.

Select Online backup.3.

Click Login.4.

If this is the first time you login to your online account in GMB 8.0 a registration form will appear. If
you do not have an online backup account, fill the information to register. Or click Login if you already
have an account.

5.

Type your email address and password in their respective fields (Email/Password) as were entered
when you signed up to the Genie-Soft online backup service.

6.

Choose between Standard and Secure data transmission.7.

Click Login now.8.

OR

From the Main page Click Online Backup Account1.

If this is the first time you login to your online account in GMB 8.0 a registration form will appear. If
you do not have an online backup account, fill the information to register. Or click Login if you already
have an account.  

2.

Type your email address and password in their respective fields (Email/Password) as were entered
when you signed up to the Genie-Soft online backup service.

3.

Choose between Standard and Secure data transmission.4.

5.

6.



4.

Click Login now.   5.

In the main screen, select Create Backup Job6.

 

You can change the Genie-Soft online account you use for backup by clicking the Change User button.
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Security Options

High data security and privacy during online backups in Genie Mail Backup are achieved through the
application of the following data-security standards:

Securing Account Passwords

This security measure is applicable even when secure online backup is not selected.

Passwords are encrypted using the SHA-256(Secure Hash Algorithm). This hash encryption algorithm is one
of the required secure hash algorithms for use in U.S. Federal applications, including the use of other
cryptographic algorithms and protocols, for the protection of sensitive unclassified information.

This Encryption methodology is a one way encryption; therefore it cannot be decrypted at the server’s side
and therefore there is no way to recover a password from the data base, the server will only be able to reset
the password and not recover it. The reset password will be sent to the user’s personal email, this process
prevents hackers from resetting the user’s account, which is a great feature to prevent user impersonation.

 

Securing Data Transmission

Genie Online Backup supports a 128- bit Secure Socket Layer (SSL) certified by the leading global provider
of SSL certificates Thawte. This protocol uses RSA encryption algorithm in order to encrypt the data on the
link and prevent hackers from eavesdropping on personal information.

This Authentication is done to reassure the clients that they are sending their information to the right source.
In other words, the certificate based authentication verifies that we are who we say we are. This
authentication is done by the SSL certificate provided by Thawte. An SSL Web Server Certificate enables
Genie Online Backup users to view the following information:

The domain for which the certificate was issued. This allows them to check that the SSL Web Server
Certificate was issued for your exact host and domain.

The owner of the certificate. This acts as further reassurance, since customers are able to see whom
they are doing business with.

The physical location of the owner. Once again this reassures customers that they are dealing with an
actual entity.

The validity dates of the certificate. This is extremely important, since it shows users that your Digital
Certificate is current.

 

Setting Secure Data Transmission:

From the left navigation menu in the backup wizard select Where to Backup.1.

Select Online Backup.2.

Click the Change User button.3.

4.



2.

3.

Make sure Secure is selected.4.

OR

From Online Backup Account in Main Page1.

Click the Change User button.2.

Make sure Secure is selected3.
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Online Backup Settings

Online Backup Settings slightly differ from other backup settings by the following:

Full Backup: Backs up all selected data every run

Backup with versioning (Incremental backup): Backups up new and modified files in a new backup
archive (disabling rollback is not supported)

Security: All security options provided in GMB are fully supported in Genie Online backup in addition to

Secure data transmission

Bandwidth Throttling: This feature enables you to limit the bandwidth used to upload backup to the offsite
Genie servers.

Purging: Control the your online space usage via purging and also number of backup versions

More settings: Power Management Options, Reset Archive bit option, and Email notification are also fully
supported
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How to: Restore/View Online Backups

From the Main Page Select Online Backup Account1.

Click Login to My Account if you are not currently logged in and enter your email account and
password. Select Secure or Standard transmission and click Login now

2.

Wait for Genie Mail Backup to list all the backups available online.3.

Select a backup job from the list.4.

Click Restore/View to restore or view your backup5.

To Restore, select the data you wish to restore and continue with restoration process6.
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Tip

You can also search and restore an individual file via catalog



How to: Restore from Genie Drive

From the Main Page Select Online Backup Account1.

Click Login to My Account if you are not currently logged in and enter your email account and
password. Select Secure or Standard transmission and click Login now

2.

Wait for Genie Mail Backup to list all the backups available online.3.

Select Genie Drive to restore files that were uploaded manually.4.

Click Restore/View or Next5.

Select the files/folders you wish to restore and choose one of the following restore modes:

Alternative: restore data to the specified path, while maintaining the original folder tree
structure.

Single folder: restore data to the specified path, after collapsing the original folder tree
structure (no subfolders).

6.
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How to: Purchase Extra Online Space

If you wish to upgrade your online backup account to another plan that offers more storage space or seats
(users), do the following:

Directly from application:

From the backup wizard, select Where to Backup.1.

Select Online backup.2.

Click Buy more space3.

OR

From the Main page Click Online Backup Account1.

Click Need more space?2.

From Internet

Open your Internet browser.1.

Go to http://online.genie-soft.com and login to your account.2.

From the main page select Billing.3.

Click Buy more space.4.

A list of extra space/seats plans that you are eligible to upgrade to will be displayed. Choose the plan
that suites your needs.

5.

  

During backup if GMB determines that the user does not have enough online backup space, it will
notify the user and give the option to purchase more backup storage space.
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How to: Delete Online backups

From the Main Page Select Online Backup Account1.

Click Login to My Account if you are not currently logged in and enter your email account and
password.  then wait for Genie Mail Backup list all the backups available online.

2.

Select the backup job from the list and click Delete Selected Job or Delete all Jobs3.

 



Optical Media

Genie Mail Backup can write to CD/DVD media of any format (DVD±RW/DVD±R/DVD-RAM/CD-R/CD-RW),
including double layer DVDs and Blu-ray, using both built-in burning capability and packet writing - with the
aid of third party software -.

To set Genie Mail Backup to backup to a CD/DVD drive, select Where to Backup from the left-hand menu,
select CD/DVD media, then select the drive letter of the recorder you wish to use.

You can backup an unlimited amount of data to CD/DVD media even if one disc does not have sufficient
space to hold all the data, since GMB will by default divide your backup into several discs (automatic disk
spanning), and all you need to do is to replace discs when prompted to do so.

Genie Mail Backup will by default use the entire amount of empty space available on each inserted disk
during backup, you can select Use fixed split size to instruct GMB to only fill up a fixed amount of space on
each inserted disc. Make sure to leave some space as a safety margin for the table of contents that will be
written to close the disc session.

If GMB fails to write to disc or is interrupted during the process, the user will be given the option to retry by
inserting a new disc, or to cancel the operation.

Genie Mail Backup checks the integrity of data written on each disc in the backup set immediately after the
disc's session is closed. If the data is corrupt, GMB will ask the user whether to proceed with backing up the
rest of the data (in the case of automatic disc spanning) or cancel the backup task.

To prevent GMB from verifying data integrity after writing to a CD/DVD, uncheck the option Verify data
after backup in the disc burning progress dialog that appears during backup.

To retrieve an updated list of supported optical recorders, make sure you are using the latest Genie Mail
Backup version using the Genie-Update tool, from the main application window click Help, then select
Supported Recorders.

GMB by default uses the maximum speed supported by both the recorder drive and the inserted media for
burning, however, for trouble shooting purposes the user can select a custom writing speed by clicking
Advanced Settings. If no disk is inserted in the drive, GMB will load the list of speeds supported by the
recorder drive, inserting a disk in the drive would cause GMB to load the list of speeds supported by both the
recorder and inserted media.
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Disc Recording Options

Genie Mail Backup uses two methods for writing a CD/DVD disc: The built-in burner and Incremental Writing
(AKA Packet Writing) using third party software.

Track-at-Once recording is what most recorders and software support today, and is the built-in default
CD/DVD recording method used in Genie Mail Backup, which means that you do not need to use third party
software to use it for writing data to optical media. Track-at-once burning does not allow manipulation of
individual files after they have been written to disc, and thus, only supports full and incremental with rollback
backup types. Purging old backups is also not supported.

Packet writing on the other hand lets you treat an optical disc as though it were a big floppy disk, allowing in
the process for the deletion and replacing of individual files, thus supporting all backup types, including
incremental without rollback (as long as data is not divided over multiple discs). However, Genie Mail Backup
supports this recording method only through the use of third party software.

 

Built-in burner vs. packet writing.

Issue Track-at-Once Packet Writing

Speed Slower. Faster (Except when backup without
compression is used).

Compatibility Readily readable on most drives. In most cases the packet writing
software used to write the data must
be installed in order to read from the
disk.

Incremental Rollback forced. Backup with rollback option disabled is
supported (new versions of files
overwrite old versions).

Purging old
backups files

Not supported. Supported as long as data is not
divided over more than one disk.

Availability Built in. Must use third party packet writing
software.

Note: Default Windows XP writing
component does not use packet
writing.

Disk space
utilization

More disk capacity. Less disk capacity; Packet Writing
consumes more space on disc.

Pre-use formatting Blank disks need not be formatted
before usage. Disks previously
written to using packet writing
software must be fully erased: Tools
> Format Re-writable CD > Full
Format.

All disks must be formatted at least
once using the third party software, to
become compatible with packet
writing.

Note: Disks formatted using one
packet writing software must be
reformatted before being used with
another.
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Using the Built-in Burner

The built-in CD/DVD burner in Genie Mail Backup can write to almost all optical media formats, including the
new dual-layer DVD and Blu-Ray technologies; no third party software is required.

To set GMB to backup to optical media using the built-in burner:

From within the backup wizard select Where to Backup.1.

Select CD/DVD media ( DVD±RW/DVD±R/DVD-RAM/CD-R or CD-RW).2.

Make sure Use packet writing Software is not selected.3.
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Incremental Writing (Packet Writing)

If your CD/DVD device is not compatible with Genie Mail Backup, or if you wish to use backup types not
supported by GMB's built-in burner, you can use third party packet writing software.

Packet writing is a term for software that lets you record data onto an optical disc directly from Windows
Explorer, My Computer, or from the File/Save As section of any computer program. Simply put, it lets you
treat a CD as though it were a big floppy disk.

When backup using third party packet writing software is selected, Genie Mail Backup will still control what
and how much data is written to each inserted disc.

CD/DVDs written with this method can only be recognized on other computers if the same third party
packet writing software is installed there too.

Free Packet-Writing software are available for download on the Internet, please refer to the following
knowledgebase article for more information: http://www.genie-
soft.com/asp/community/KnowledgeArticle.asp?KBID=128

 

To set GMB to write to CDs and DVDs using third party packet writing software:

From within the backup wizard select Where to Backup.1.

Select CD/DVD media ( DVD±RW/DVD±R/DVD-RAM/CD-R or CD-RW).2.

Select Use third party packet writing Software.3.
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Formatting Optical Media

GMB comes with a CD/DVD formatting tool that can perform both quick erase and full disc format.

This feature can only be used with re-writable optical media.

New blank discs need not be formatted before using them with Genie Mail Backup. However, if the disk
has been written to previously using a packet writing software then it needs a full format before GMB
can use it for backup.

When using packet writing, make sure the disc you wish to backup to has been formatted using the
third party packet writing software.

 

Setting a backup job to automatically erase CD/DVD discs before backup:

From the left navigation menu in the backup wizard select Where to Backup.1.

Select CD/DVD media ( DVD±RW/DVD±R/DVD-RAM/CD-R or CD-RW).2.

Make sure Automatically erase disc before backup is selected.3.

 

Automatic disc erase uses quick erase, not full format.

 

Manually erasing CD/DVD discs:

From the toolbar click Tools, then select Format Re-Writable CD/DVD.1.

Select the drive letter of the recorder containing the disk you wish to erase.2.

Select one of the following options:3.

Quick Erase: Quickly delete the contents of the disk (takes around 1-2 minutes to complete)

Format: Fully format disc (might take around 30 minutes or more to complete).

 

Quick erasing re-writable disks might render them ‘stubborn’ after a number of erases, it is
recommended to perform a format every 7-10 quick erase sessions to revitalize the disk.
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How to: Restore from Optical Media

To restore data stored on CD or DVD discs:

Insert the last disc in the backup set into the drive.1.

Open the Restore wizard.2.

Click Select backup set.3.

Browse to the CD/DVD drive and select the catalog ".gbp file".4.

Click Open.5.

 

 

 

 

 

Copyright (c) 2007 Genie-Soft, Inc. All rights reserved.



CD/DVD Backup Strategies

GMB offers flexibility and reliability when backing up to CD/DVD. Here are some strategies to make your
backup reliable and more flexible:

Use blank CD/DVDs: For reliable backups it is recommended that you use blank (new) CD/DVDs to
ensure that the CD/DVD does not contain scratches from extensive use.

1.

Create full backup on high capacity media: Backing up to CD/DVD is much slower than backing up
to a hard drive. Also DVD's even if dual layered cannot compare with the high capacity Hard drives. In
GMB you can create your full backup on an external drive, edit your job, select incremental on
CD/DVD. Please make sure Read index from catalog (Enable changing storage location) is
selected from Tools> Global Preferences> Cataloging

2.

Use packet writing software to purge backups: you can enable purge option using packet writing
software as it enables writing to CD/DVD as if you were backing up to a hard drive. Packet writing also
allows you to perform incremental backups with rollback disabled.

3.
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Removable Media

Removable media devices include floppy disks, JAZ drives, ZIP drives, memory sticks, etc. Removable media
is a practical backup destination, because it allows automatic media spanning, i.e. GMB would backup to the
inserted volume until all available space has been consumed then prompt the user to insert a new disk, and
so on, until all data has been written.

To set Genie Mail Backup to backup to a removable media device, open the backup wizard, select Where to
Backup, then select Multiple Disks (Removable Media Devices). A list of all attached removable media
devices will be displayed to choose from. External hard disk drives are now detected under removable
media; however, you may backup external harddisk under Local/LAN option to enable multi-drive spanning.
For more information, see Backup to Internal and External Drives.

You can backup an unlimited amount of data removable media even if one volume does not have sufficient
space to hold all the data, since GMB will divide your backup into several discs, and you only need to replace
discs when the program prompts you to do so.

Select Automatically erase contents of disk before backup if you wish to save time by allowing GMB to
quick-format each inserted volume during backup.

REV® devices are implicitly supported in GMB
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REV Device Settings

Now GMB supports Iomega REV operations to ensure a more reliable and non interrupted backup. These
settings include:

Eject disk after backup: After backup completes, GMB safely and automatically ejects REV disc after
backup. This procedure is similar to right-clicking the REV drive icon in My Computer or Windows Explorer
and select Eject.

Disable write protection during backup/enable after backup: If you insert a write protected REV disk
prior backup any traditional backup program or a simple copy to disk cannot be achieved if write protection
is enabled. Selecting this option will check if your REV disc is write protected and will disable it before
backup. In addition to that, when backup completes, write protection will be automatically enabled.

Disable access protection during backup/enable after backup:  Access protection prevents anyone
without the password from adding, deleting, modifying, or viewing your files. Therefore, if this option was
enabled prior backup, GMB will fail to perform backup. However, using this option and entering the access
protection password in the Password field will automatically disable access protection before backup and
enable it afterwards.

Notes:

If write protection and access protection were originally disabled, GMB will not enable it after backup

 



How to: Restore from Removable Media

To restore data stored on removable media:

Make sure the last storage volume from the backup set is inserted/connected.1.

Open the Restore wizard.2.

Click Select backup set.3.

Browse to removable media drive and select the catalog ".gbp file".4.

Click Open.5.
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The Default Backup Destination

When a new backup job is created, the backup destination option (where to backup) will be set to a default
local folder, typically "My Documents\My Backups", which can be later changed by the user.

To change GMB's default backup folder select Tools from the toolbar, select Global Preferences, select
Backup Settings, and enter a new path in the Default backup destination box. Note that the default
backup destination can only be set to point to a local or networked location.

To view the contents of the default backup folder click File from the toolbar then select Default Backup
Folder.
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Media ID

During backup to removable or optical media, Genie Mail Backup will assign a different id (label) to each
disc/volume for identification. It is recommended to mark the media with this label, since GMB will refer to it
as it prompts the user to replace disks during restore or when attempting to add new versions to a backup.

GMB names each disk using the following naming scheme:

<Backup Job Name> - <Volume Number>

Where:

Backup Job Name: is the name assigned to the backup job.

Volume Number: indicates the disk's number according to the sequence in which volumes where
inserted during backup.

 

To change the Media ID:

From the left navigation menu in the backup wizard select Settings.1.

Click Advanced Settings.2.

Make sure Change media ID is selected.3.

Type a new label to be used instead of the backup job name.4.
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My Mail

This user data group contains various built-in plugins that you can use to backup some of the most
important items on your computer; these include Emails, Favorites, Windows Settings, Desktop files and
folders etc. The items in this group were selected to include the data types most commonly backed up during
system formats.

My Mail items can be migrated between different computers or different versions of Windows safely; one can
backup his favorites, for instance, from a Windows XP machine and restore them on a Windows 2000
machine, and GMB would know exactly where to copy the files.

Selecting an item from the left pane displays a list of selection refinements in the right pane, along with
item-specific settings.

 

 

 

 

 

Copyright (c) 2007 Genie-Soft, Inc. All rights reserved.



Backing up Email Clients Data

Genie Mail Backup offers backup options for of the most commonly used email clients: Ms Outlook (2000-
2007, Windows Mail, and Outlook Express.

 

 

 

 

 

Copyright (c) 2007 Genie-Soft, Inc. All rights reserved.



MS Outlook

Genie Mail Backup can help you to backup all your Outlook data or transfer your existing Outlook profile(s)
from one computer to another. Using Genie Mail Backup you can migrate your Outlook profile between
different versions of Windows.

 

MS Outlook Data Items that GMB Can Backup:

Main data files (Outlook.pst, Archive.pst) and additional data files created by the user.  

Extensions (addins).

Settings and preferences, including customized toolbar settings, contacts and nicknames, send and
receive settings, navigation pane settings, rules etc ...  

Signatures: The blocks of formatted text and/or graphics that appear at the end of e-mails send that
identify yourself and your contact information.

Stationery: Stationery and themes are a set of unified design elements and color schemes you want to
apply to messages. They specify fonts, bullets, background color, horizontal lines, images, and other
design elements you want to include in outgoing e-mail message

Custom Forms: Custom forms created by outlook users. Forms are an easy way to distribute and
collect information electronically.

E-mail accounts: POP3, IMAP and HTTP e-mail accounts

Miscellaneous options set by the user while using Microsoft Outlook such as: notifications, displays,
read receipts, sending options and formats, maintenance preferences, etc...

Categories: Any Microsoft Outlook item can be assigned to one or more categories. Consistent use of
categories makes it easier to locate specific items.
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Outlook Data Files

The following is a list of MS Outlook files that GMB can backup.

Description Stored in Typical File Location

Outlook data files (.pst) drive:\Documents and Settings\<user>\Local Settings\Application
Data\Microsoft\Outlook

Offline Folders file (.ost) drive:\Documents and Settings\<user>\Local Settings\Application
Data\Microsoft\Outlook

Personal Address
Book

(.pab) drive:\Documents and Settings\<user>\Local Settings\Application
Data\Microsoft\Outlook

Offline Address
Books

(.oab) drive:\Documents and Settings\<user>\Local Settings\Application
Data\Microsoft\Outlook

Command bar and
menu
customizations
(.dat)

(.dat) drive:\Documents and Settings\<user>\Application Data\Microsoft\Outlook

Navigation Pane
settings.
This file includes
Shortcuts,
Calendar, and
Contact links.

(.xml) drive:\Documents and Settings\<user>\Application
Data\Microsoft\Outlook\Outlook.xml

Outlook contacts
nicknames

(.nk2) drive:\Documents and Settings\<user>\Application Data\Microsoft\Outlook

Rules (.pst) drive:\Documents and Settings\<user>\Application Data\Microsoft\Outlook

Note: If you upgraded from a version of Outlook prior to Outlook 2002, you
may have a .rwz file on your computer hard disk drive. The file is no longer
needed and the rules information is now kept on the server for Microsoft
Exchange e-mail accounts, and within the personal folders file (.pst) for
POP3 and IMAP e-mail accounts. You can delete the file.

Print styles (Outlprnt with
no extension)

drive:\Documents and Settings\<user>\Application Data\Microsoft\Outlook

Signatures (.rtf, .txt,
.htm)

drive:\Documents and Settings\<user>\Application
Data\Microsoft\Signatures

Stationery (.htm) drive:\Documents and Settings\<user>\Application Data\Microsoft\Stationery

Custom forms   drive:\Documents and Settings\<user>\Local Settings\Application
Data\Microsoft\Forms

Dictionary (.dic) drive:\Documents and Settings\<user>\Application Data\Microsoft\Proof



Templates (.oft) drive:\Documents and Settings\<user>\Application
Data\Microsoft\Templates

Send/Receive
settings

(.srs) drive:\Documents and Settings\<user>\Application Data\Microsoft\Outlook

Message (.msg, .htm,
.rtf)

drive:\Documents and Settings\<user>\My Documents
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How to: Backup MS Outlook Data

Log in to the Windows account using the Outlook profile(s) you wish to backup.1.

From the left navigation menu in the backup wizard select What to Backup.2.

Select My Mail tab.3.

Expand the Outlook tree to view available profiles.4.

Select the checkboxes next to the profiles you wish to backup.5.

From the right-hand pane select the desired Outlook data items for each profile.6.
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How to: Restore Outlook Data

Although Genie Mail Backup can backup multiple Outlook profiles simultaneously, each profile must be
restored separately.

Open the restore wizard.1.

Load a backup, then click Next.2.

Make sure the My Mail tab is selected.3.

From the left-hand pane, expand the tree under Outlook, then select a profile.4.

From the items list pane select the Outlook Data Items you wish to restore.5.

Choose one of the following options:6.

Create a new profile: create a new profile, and restore data to it.

Overwrite existing profile: overwrite existing profile with the one being restored.

Append to Existing profile: merge restored profile with an existing one. PST files will be
appended as additional data files, not synchronized.

If you wish to restore another Outlook profile, run Outlook once, then close it and repeat steps 1
through 6

7.
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Outlook Express

Genie Mail Backup can help you to backup all your Outlook Express data or transfer your existing Outlook
Express identity from one computer to another. Using Genie Mail Backup you can also migrate your Outlook
Express emails and settings between different versions of Windows.

GMB is also the first and ONLY Outlook Express backup utility to allow users to view, read, print, and extract
emails directly from the backup without restoring them first.

Outlook Express makes it easy for two or more users on the same PC to keep their mail separate using
identities. GMB can backup multiple Outlook Express identities simultaneously.

Selecting an Outlook Express mail folder will automatically select all its subfolders.

To select an Outlook Express mail folder without its subfolders or to deselect a folder without un-
selecting its subfolders, right-click on the checkbox next to it.
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How to: Backup Outlook Express

From the left navigation menu in the backup wizard select Where to Backup.1.

Select My Mail tab.2.

Expand the Outlook Express tree to view identities available for backup.3.

Select the checkboxes next to the identities you wish to backup.4.

From the right-hand pane select the desired Outlook Express data items for each identity.5.
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How to: Restore Outlook Express Data

Although Genie Mail Backup can backup multiple Outlook Express identities simultaneously, each identity
must be restored separately.

If you are restoring to a new Windows installation, you must start Outlook Express once before
attempting to restore.

1.

Open the restore wizard.2.

Load the backup, then click Next.3.

Make sure the My Mail tab is selected.4.

From the left-hand pane, select the identity you wish to restore.5.

From the items list pane select the Outlook Express data items you wish to restore.6.

Click Select identity.7.

Choose an identity from the list and click Select.8.

Click Back to Restore.9.

Finish selecting other backup items and click Next to start restore.10.

Repeat steps 2 through 10 to restore additional Outlook Express identities.11.
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How to: Synchronize Outlook Express Mail Folders

Genie Mail Backup isn't an Outlook Express synchronization tool per se', however, GMB offers a work around,
by restoring data to a dummy temporary identity, from there the user can use Outlook Express import
functionality to synchronize emails form the existing identity with emails from the restored identity.

To synchronize Outlook Express Emails:

Open the restore wizard.1.

Load a backup, then click Next.2.

Make sure the My Mail tab is selected.3.

From the left-hand pane, select the identity you wish to restore.4.

From the items list pane select the Outlook Express data items you wish to restore.5.

Click Select identity.6.

Choose an identity from the list, then click Select.7.

Select Synchronize my emails.8.

Click Ok and complete the restore process.9.

When restore is complete, run Outlook Express.10.

From the File menu select Import then select Messages.11.

Select Microsoft Outlook Express.12.

Select Genie Backup Identity and click Next until you reach the Select Folders page.13.

Choose one of the following options:14.

Import all.

Selected Folders.
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How to: Synchronize Outlook Express Settings

To synchronize settings and email accounts from a backed up Outlook Express identity with an existing
Outlook Express identity do the following:

Open the restore wizard.1.

Load the backup, then click Next.2.

Make sure the My Mail tab is selected.3.

From the left-hand pane, expand the Outlook Express list, then select an identity.4.

From the item list pane, make sure Outlook Express Root is not selected, and select Outlook
Express Data.

5.

Click Select identity.6.

Choose an identity from the list, then click Select.7.

Click Back to Restore.8.
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How to: Extract Mail Folders Directly from a Backup

This features allows you to extract an Outlook Express mail folder directly from backup without having to
restore the entire identity.

Open the restore wizard.1.

Load the backup, then click Next.2.

Make sure the My Mail tab is selected.3.

From the left-hand pane, select an identity.4.

From the items list pane, expand the Outlook Express Root tree, and select an email folder.5.

Click Extract.6.

Select a folder then click Ok.7.
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How to: View Backed Up Emails

GMB is the first Outlook Express backup utility to allow users to view, read, print, and extract emails directly
from the backup without restoring them first.

Open the restore wizard.1.

Load the backup, then click Next.2.

Make sure the My Mail tab is selected.3.

From the left-hand pane, select an identity.4.

From the items list pane, expand the Outlook Express Root tree, then select an email folder.5.

Click View Emails.6.
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Windows Mail

Windows Mail is the successor to Outlook Express. Windows Mail builds on the foundation of Outlook Express,
adding a variety of new features designed to make your e-mail experience more productive and fun, while
helping to reduce risks and annoyances such as phishing and junk e-mail. With GMB, users can backup and
restore Windows Mail emails, accounts, rules, and stationary simply and easily with a click of a button.

Windows Mail Data Items that GMB Can Backup:

Mail: Inbox, Outbox, drafts, Deleted Items, Junk email folders, and all user defined folders for emails

Accounts: Email accounts, Internet news accounts and Directory Service accounts.

Rules: Message rules created in Windows Mail

Settings: This includes the options the user selects and sets while using Windows Mail such as:
notifications, displays, send/receive message options, read receipts, sending options and formats,
maintenance preferences, etc...

Stationery: Stationery and themes are a set of unified design elements and color schemes you want to
apply to messages. They specify fonts, bullets, background color, horizontal lines, images, and other
design elements you want to include in outgoing email messages.

 

 

 

 

 



How to: Backup Windows Mail Data

From the left navigation menu in the backup wizard select Where to Backup1.

Select My Mail tab2.

Select Windows Mail3.



How to: Restore Windows Mail Data

Open the Restore wizard.1.

Load the backup, then click Next.2.

Make sure the My Mail tab is selected.3.

From the left-hand pane, select Windows Mail4.

Select one of the following options:5.

Overwrite:This option enabled GMB to add missing emails, stationery to your current configuration. This
method is recommended even if you are restoring to a new installation

Merge:This option enabled GMB to add missing emails, stationery to your current configuration. This method
is recommended even if you are restoring to a new installation



Windows Address Book

Windows Address Book is where contact information is stored. This information is used by programs such as
Microsoft Outlook, Microsoft Outlook Express, Microsoft Internet Explorer, Microsoft NetMeeting, and
Microsoft Phone System.
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How to: Back Up Windows Address Book

From the left navigation menu in the backup wizard select What to Backup.1.

Select My Mail tab.2.

Select Windows Address Book.3.
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How to: Restore Windows Address book

Open the restore wizard.1.

Load the backup, then click Next.2.

Make sure the My Mail tab is selected.3.

From the left-hand pane, select Windows Address Book.4.

 

Windows Address Book contacts are listed according to Outlook Express identities, to be able to view
the restored Windows Address Book contacts properly make sure restored Outlook Express identities
keep their old names. Otherwise synchronize your Windows Address Book data.

 

 

 

 

 

Copyright (c) 2007 Genie-Soft, Inc. All rights reserved.



How to: Synchronize Windows Address Book Contacts

Restoring Windows Address Book will replace the existing WAB file on the machine. The user can manually
synchronize the existing address book with the backed up version by doing the following:

Open the restore wizard.1.

Select the backup set, then click Next.2.

Make sure the My Mail tab is selected.3.

From the left-hand pane, select Windows Address Book.4.

Click View Backed Up Windows Address Book.5.

From the toolbar click File, then select Export.6.

Select WAB Address Book, and save the WAB file in a temporary location.7.

Run Outlook Express.8.

From the toolbar click File, then select Import.9.

Select Address Book.10.

Browse to the location of the saved WAB file and select it then click Ok.11.
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Windows Contacts

Microsoft Windows Vista provides a new mechanism and user interface for storing and retrieving information
about people (contacts) who are important to the users of Microsoft Outlook and Windows Mail (formerly
Outlook Express)



How to: Backup Windows Contacts Data?

From the left navigation menu in the backup wizard select What to Backup1.

Select My Mail tab2.

Select Windows Contacts3.

Select Include Windows Live Contacts (if available) if you wish to backup Windows Live contacts.4.
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How to: Restore Windows Contacts

Open the restore wizard.1.

Load the backup, then click Next.2.

Make sure the My Mail tab is selected.3.

From the left-hand pane, select Windows Contacts4.

 

Note:

This option is used to restore Windows contacts backed up originally via GMB, restoring windows contacts
will only restore missing contacts and will not delete newly created contacts that were not originally backed
up via GMB.
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Windows Favorites

In Microsoft Internet Explorer you can tell the program to remember a list of your "favorite" Web pages, so
that you can go back to them easily, without having to type in the address (URL) again. Genie Mail Backup
allows you to backup your Favorites, transfer them from one computer to another, or migrate them between
different versions of Windows.
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How to: Back Up Windows Favorites

From the left navigation menu in the backup wizard select What to Backup.1.

Select My Mail tab.2.

Select Favorites.3.
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How to: Restore Windows Favorites

Open the restore wizard.1.

Load the backup, then click Next.2.

Make sure the My Mail tab is selected.3.

Select Favorites.4.
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Internet Explorer

GMB enables the user to backup the following items that define the way Internet Explorer functions:

Internet Explorer Settings: Home page, security, privacy, content, connections, programs, and
advanced settings.

Internet Explorer Cookies: Cookies are small text files that some web sites use to store information
on your PC, among other reasons they are used sometimes to grant you access next time around to
the web site or for customization features.
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How To: Backup Internet Explorer

From the left navigation menu in the backup wizard select What to Backup1.

Select My Mail tab2.

Select  Internet Explorer3.

In the right-hand pane,  select one of the following options:4.

Internet Explorer Settings: Home page, security, privacy, content, connections, programs, and
advanced settings.

Internet Explorer Cookies: Cookies are small text files that some web sites use to store
information on your PC, among other reasons they are used sometimes to grant you access next
time around to the web site or for customization features.
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How to: Restore Internet Explorer Settings

Open the Restore wizard1.

Select the backup set, then click  Next2.

Make sure the My Mail tab is selected3.

From the left-hand pane, select Internet Explorer Settings4.
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Windows Settings

GMB gives users the ability to backup the following selection of personalized Windows settings and
configurations:

Desktop Wallpapers: Desktop wallpaper settings and background image.

Visual Appearance: Shapes, sizes and colors of windows, buttons and fonts.

International settings: Regional settings, Time, Date, Currency and Number formats.

Mouse Preferences: Mouse pointer behavior settings.

Mouse Cursors: Preferred mouse cursor scheme.

Connections Settings: Network connection accounts. Backing up Dialup Preferences will only backup
network connection settings; needed protocols should already be installed and the modem should
already be configured.

Power Settings: PC power options properties located in the control panel.

Consol Settings: Windows command prompt settings, options, colors, font and layout.

Multimedia: For storing favorite sound, audio, and video settings plus the sounds scheme; sounds
associated with events in the windows system.

Advanced Settings: Saves Windows Explorer advanced view settings, such as hide extensions, show
system files etc...
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How to: Back Up Windows Settings

From the left navigation menu in the backup wizard select What to Backup.1.

Select My Mail tab.2.

Select Windows Settings.3.

Select the individual Windows settings items that you want to backup.4.
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How to: Restore Windows Settings

Open the restore wizard.1.

Load the backup, then click Next.2.

Make sure the My Mail tab is selected.3.

From the left-hand pane, select Windows Settings.4.

From the items list pane select the individual items you wish to restore.5.
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My Files

Genie Mail Backup allows you to backup important files by adding them from different location. However, for
a comprehensive solution to backup files, folders, programs, program settings and disaster recovery, you
can always upgrade to Genie Backup Manager.

 

 

 

 

 

Copyright (c) 2007 Genie-Soft, Inc. All rights reserved.



How to: Backup My Files

From the left navigation menu in the backup wizard select What to Backup.1.

Select My Mail tab.2.

Select My Files.3.

Click Add Files and browse for the files you wish to add.4.

 

Note

To remove files from the list, select the files and click Remove Files
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How to: Restore My Files

Open the restore wizard.1.

Load the backup, then click Next.2.

Make sure the My Mail tab is selected.3.

From the left-hand pane, select My Files.4.

From the My Files list pane select the individual files you wish to restore.5.

In Select Restore Location, browse for the location your wish to restore the files.6.
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Backup Types

There are two types of backups supported by GMB that depend on whether the user wants to backup all the
selected data, or just new and changed files. Backup types are: Full or Incremental.

The first run always backs up all selected files and folders, and a backup catalog (.gbp file) is stored on the
destination media. On subsequent runs, Genie Mail Backup searches for the catalog ".gbp file" in the
destination. If the media is empty or it does not contain the catalog file, GMB will start with a new full
backup. If the catalog file is found, GMB will make a new version, with a new version of the catalog file,
depending on the selected backup type and versioning settings.

Genie Mail Backup also stores a local copy of the catalog file on the computer on which the backup is
performed. If you do not wish GMB to look for the file in the destination media - for instance, to store
different versions on separate media volumes - you can set GMB to read the index from the local
catalog.

You can disable reset archive bit, if you do not want GMB to reset archives. This option will not affect
on the backup jobs ran on GMB

Notes:

Incremental  backups are not supported in Easy mode

For Online Backup types, see Online Backup Settings
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Full Backup

When a user selects Full backup, GMB will back up all the selected files and folders each time the backup job
is run. New files will also be appended to the selection. On consecutive runs, in general, this backup type is
more time and space consuming than the other three backup types, but is more user friendly.

To set GMB to always run a full backup, select Full, from the Settings screen in the backup wizard.

This backup type is best for one-time backups to migrate data between computers.
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Incremental Backup

In incremental backup, the first run always backs up all selected files and folders, and a backup catalog (.gbp
file) is stored on the destination media. On subsequent runs, Genie Mail Backup searches for the catalog
".gbp file" in the destination. If the media is empty or it does not contain the catalog file, GMB will start with
a new full backup. If the catalog file is found, GMB will create a new backup version, containing only files that
have been added or modified since the previous run. A new version of the catalog file will be appended to
the media, and files that were deleted, renamed or moved from the source machine will not be deleted from
the backup archive, but they will not be included in the last version of the catalog.

To set GMB to use incremental backup, select Increment, from the Settings screen in the backup wizard.

Incremental backup, by default, uses the files' "modified date and time" attribute to determine which
files have been modified since the previous backup run.

 

Rollback

Enabling rollback during increment backup will cause GMB to keep old versions of modified files backed up in
previous runs; this way the user can still restore (rollback to) any backed up older version of a certain file to
protect against losing data by mistake.

With rollback enabled, each backup run will create a new file on the destination media - or a new folder if
compression was disabled - containing new and changed files, and a new catalog ".gbp file" will be added to
the root backup folder, with a trailing number appended to the filename; this number will be incremented by
one for each new version,  starting with zero (0) on the second run.

Example:

Backup Job.gbp ... First run.

Backup Job.0.gbp ... Second version.

Backup Job.1.gbp ... Third version.

Backup Job.2.gbp ... Fourth version.

 

Disabling rollback means that GMB will append new files to the original backup file/folder, while modified
files will overwrite older versions.

When backup using compression is selected, if the data after compression exceeds 2GB in size, rollback will
be forced.

The catalog will only contain one entry during incremental backup with rollback disabled. Each new
version catalog will replace the previous one.

Disabling rollback is not supported when FTP backup is selected.

Backup without rollback is not supported backing up to Online

Backup without rollback is not supported when media is not re-writable, or if the user does not have



delete permission on the destination.

To backup to CD/DVD with rollback disabled, media needs to be re-writable and packet writing
enabled.

Backup without rollback is not supported when spanning to more than one location
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Security in Genie Mail Backup

Genie Mail Backup offers multiple levels of protection to ensure that backed up data is not accessible to
unauthorized persons. ZIP passwords offer moderate protection for compressed backups, with the added
flexibility of being compatible with most compression utilities, to allow users to manually restore data from
backup archives, while AES encryption has the advantage of being highly secure, as it is adopted by NIST as
an FIPS-approved (Federal Information Processing Standard) symmetric encryption algorithm that may be
used by U.S. Government organizations (and others) to protect sensitive information

Our online backup solutions enjoy an added level of protection, through username and password encryption,
as well as 128- bit Secure Socket Layer (SSL) data transmission, certified by the leading global provider of
SSL certificates, Thawte.
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Zip Password Protection

Genie Mail Backup uses standard zip format compression, and thus can add a standard zip compression
password to the created archive; using this protection method would still allow users to access their data
using ZIP-compatible compression utilities. Users will not be able to browse or restore files and folders
stored inside a ZIP-password-protected backup until they enter their passwords.

This method only offers moderate protection; it is not recommended for securing sensitive data.

ZIP passwords cannot be less than 6 characters long.

 

To add zip password protection to a backup job:

From the left navigation menu in the backup wizard select Settings.1.

From the Security box select Password Protection.2.

Type a password twice in the Password and Confirm Password fields3.
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Encryption

Encryption is encoding data to prevent any non-authorized party from reading or changing it. The level of
protection provided by encryption is determined by an encryption algorithm. The contents of the data that
you want to protect are encrypted based on a password that you specify. In order for GMB later restore the
original contents of the encrypted files, the correct password must be supplied

 

AES Encryption

GMB uses AES encryption. AES is the Advanced Encryption Standard. This encryption method, has been
adopted by NIST as an FIPS-approved (Federal Information Processing Standard) symmetric encryption
algorithm that may be used by U.S. Government organizations (and others) to protect sensitive information

GMB supports 128-bit AES encryption. The number refer to the size of the encryption keys that are used to
encrypt the data; the higher the number the stronger the encryption, at the expense of being slightly slower.
All three methods can provide significantly greater security than the password protection method.

The strength of encryption does not depend only on the length of the encryption key used but also on the
password supplied by the user. Please read more about Encryption Passwords

GMB requires that the correct password be supplied before the contents of an encrypted backup set
can be viewed or restored to its original unencrypted form. The password is not required, however, for
actions that do not require access to the unencrypted contents of the file. In particular, encrypted files
can be deleted from backup set, or can be replaced within the backup set, without a password

 

Notes on encryption safety

Encryption can be a very effective measure for protecting your sensitive data; however, even encrypted
documents can be compromised . The following is a list of some of the ways in which the safety provided by
encryption can be compromised. Note that these are not GMB related risks but rather risks that arise from
mishandling the password or a file in its unencrypted form

If a keystroke monitor (key-logger) or other malicious code (such as a trojan horse) is running on your
computer, your password may be recorded when you type it. Be sure to check frequently for viruses and
follow other recommended computer safety procedures

If you extract an encrypted file and then delete it, it may be possible for someone to later "undelete" the file
using file recovery software or the Recycle Bin. You can use the Genie Wipe tool to irreversibly delete
sensitive files

When you extract, open or view a file directly from the backup set (using Catalog or from the Restore
Wizard), GMB must extract the file to a temporary location so that the associated program can open it. If
you subsequently close GMB without first closing the program that is using the file, GMB may not be able to
delete the temporary copy of the file, thereby leaving it on disk in unencrypted form. The associated
program may also make one or more backup copies of the decrypted file, and GMB will not be able to delete
these

After backing up or restoring encrypted files, some or all of the unencrypted file contents may remain in your
computer's memory or the page swap files on disk. A malicious user may be able to retrieve this
unencrypted information  
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Using Encryption in Backup

GMB can protect backed up data from being accessed by unauthorized people using AES encryption. GMB
encrypts data on-the-fly, meaning that it encrypts files as they are being copied to the backup storage
device instead of first encrypting the entire data then backing it up.

To add AES encryption protection to a backup job:

From the left navigation menu in the backup wizard select Settings.1.

Select AES Encryption.2.

Type a password twice in the Password and Confirm Password text input boxes.3.

Click Encryption Strength.4.

Choose an encryption level.5.

 

Note

Encryption applies only to the contents of backed up files. Information about an encrypted file, such as
its name, date, size, and attributes, can be viewed, without a password, by anyone who has access to
the backup set.

Encryption is not supported in Easy Mode

 

Decrypting data during restore

Upon selecting a backup set with encryption protection for restore, GMB will request the encryption
password. The user will not be allowed to browse, view, extract or restore data unless the correct password
is supplied.
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Encryption Passwords

The security of your data depends not only on the strength of the encryption method but also on the
strength of your password, including factors such as length and composition of the password, and the
measures you take to ensure that your password is not disclosed to unauthorized third parties.

You should keep the following considerations in mind when choosing passwords for your files:

Encryption password cannot be less than 6 characters long

In general, longer passwords are more secure than shorter passwords. To take maximum advantage of
the full strength of AES encryption passwords lengths must be approximately:

15 characters for 128-bit encryption.

Passwords that contain a combination of upper and lower case letters, digits, and punctuation are more
secure than passwords containing only letters.

Because you can use spaces and punctuation, you can create "pass phrases" that are long enough but
still easy to remember and type.

Avoid using easily guessed passwords such as names, birthdays, Social Security numbers, addresses,
telephone numbers, etc...

Avoid storing the password on the same volume on which the encryption data is located.

Keep a record of the passwords you use and to keep this record in a secure place. GMB has no way to
access the contents of an encrypted file unless you supply the correct password.
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Understanding Backup Sets and Purging

When the storage media is re-writable, and the user has the right folder privileges, Genie Mail Backup can be
set to delete old backup files created by the backup job, to save space. The way purging old backups works
varies depending on the backup type used.

 

To set GMB to purge old backup files created by a backup job:

From the left menu in the Backup Wizard, select Settings.1.

Click Purge Settings.2.

Select one of the following options:3.

Keep old backups: Do not delete old backups

Keep only last X backups: Keep only the last X backup files and delete files produced by older
backups

Keep old backups for a period of X days: Delete any backup file older than X days

 

Backup Sets

To understand how purging works in Genie Mail Backup, the user needs to be familiar with the concept of
Backup Sets. For the purpose of this help documentation, a backup set is the minimum collection of backup
files - or folders, in the case of backup without compression - that are needed to successfully perform a
restore. For example, if the user wishes to restore files that were backed up using an incremental backup job
on March 23rd, then every backup file created by this backup job since that date and back to the most
recent full backup before that date should be present and are considered a backup set.

Purging works with backup sets and not backup runs. if the user chooses to "keep the last 5 backups", that
means that Genie Mail Backup will always keep the most recent 5 backup sets created by that job.

 

Purging with Full Backup

Full backup copies all the selected files each time the backup is performed. Each time a full backup is
performed, a new backup set is created, and a bracketed number after the backup job name is incremented
by one, to denote the backup run number.

Since each backup run creates a backup set, keeping the last X backup sets means keeping the backup files
produced by the most recent X backup runs.

Ex:

A full backup is performed, job name is "My_backup", and purging option selected is "keep only last 4
backups".



1st run My_backup.gbp is created

2nd run My_backup(1).gbp is created

3rd run My_backup(2).gbp is created

4th run My_backup(3).gbp is created

5th run My_backup(4).gbp is created and My backup.gbp
is deleted

6th run My_backup(5).gbp is created and My
Backup(1).gbp is deleted

7th run My_backup(6).gbp is created and My
Backup(2).gbp is deleted

 

Purging with Incremental Backup

During incremental backups, the first backup run performed after the backup job is created is a Full backup,
subsequent backup runs are all incremental until the user elects to reset the backup job to full, either
manually or automatically using the "Limiting increments" feature. GMB treats each full backup and all
subsequent increments until the next full run as a complete backup set.

For each backup run that is performed, a number after the backup job name is incremented by one, when
backup is switched to full, that number is reset and another bracketed number is incremented by one to
denote the number of full backups performed since the backup job was created.

When purging is selected, backup rotation is forced, which means that after a certain number of incremental
backups, Genie Mail Backup will automatically reset the backup type to full for one backup run, then
performs another set of incremental backup runs, then resets to full again, and so on.

If the user enables purging with the option to "Keep only last X backups", Genie Mail Backup will reset
backup type to full "full" X time, and on the X+1 run, it will delete the oldest backup set.

Example

An incremental backup is performed.

Job name: "My_backup"

Purging option: "keep only last 3 backups"

Backup rotation: 2 increments.

* Bold denotes the creation of a new backup set.



1st run My_backup.gbp is created (Full backup) .

Backup Set2nd run My_backup.0.gbp is created (increment).

3rd run My_backup.1.gbp is created (increment).

4th run My_backup(1).gbp is created (Full backup) .

Backup Set5th run My_backup(1).0.gbp is created (increment).

6th run My_backup(1).1.gbp is created (increment).

7th run My_backup(2).gbp is created (Full backup) .

Backup Set8th run My_backup(2).0.gbp is created (increment).

9th run My_backup(2).1.gbp is created (increment).

10th run My_backup(3).gbp is created (Full).

My_backup.gbp, My_backup.0.gbp &
My_backup.1.gbp are deleted Backup Set

11th run My_backup(3).0.gbp is created (increment).

12th run My_backup(3).1.gbp is created (increment).

13th run My_backup(4).gbp is created (Full).

My_backup(1).gbp, My_backup(1).0.gbp &
My_backup(1).1.gbp are deleted

 

 

 

Rotating Backups

When increment backup is used, the user can set GMB to automatically switch to full backup after a specific
number of increments. Each full backup and its subsequent increments are treated by GMB as one backup
set, enabling the user to purge old backup sets safely.

To set GMB to limit the number of increments for each backup set:

From the left menu in the Backup Wizard, select Settings

Click Purge Settings.1.

Select the Limit increments option.2.

In Number of increments, type the number of increments you wish GMB to perform before switching
to full backup .

3.

 



3.
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Understanding Archive Bit and Backup Types

The archive bit is a file attribute that is set whenever a file is modified. For backups that use archive bits,
this bit is turned off after the backup completes, indicating to the system that the file has been backed up. If
the file is changed again before the next backup, the bit will be turned on and Genie Mail Backup will back up
the file.

Whenever a file is created or changed, the operating system activates the Archive Bit or modified bit . By
default, unless you specifically select to use the archive bit, Genie Mail Backup uses the last modified date
and time stamp to determine whether a file has been backed up.

Using the archive bit in determining changed files, however, can cause confusion if the user is not careful, if
the data selection for more than one backup job overlap. To explain this, consider this scenario: Jack has
two backup jobs that he has scheduled to run consecutively, named Documents and Work . The folder
Monthly Reports was selected to be backed up by both backup jobs. Come backup time, the job Documents,
will backup the folder the turn off the archive bit. When its time for the job Work to run, it will find that the
folder has already been backed up and skips the folder.

When the archive bit method is used with full or increment backup, GMB will turn off the archive bit after
each backup run.

To set GMB to reset the archive bit after backup:

From the left menu in the backup wizard Select Settings.1.

Click More Settings then select Advanced Settings.2.

Select Reset the Archive Bit.3.

 

To use the archive bit in determining changed files:

Click the Start menu in the Windows toolbar, then select Run.1.

Type regedit.2.

Browse the registry until you reach the following key:
HKEY_CURRENT_USER\Software\Genie-Soft\GMBAPPLICATION\Main\

3.

Double-click the value CompareMethod.4.

Set the value to 0 (zero).5.
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Adding a Timestamp to the Backup File

A timestamp is a combination of date + time that is appended at the end of the backup filename to indicate
when the backup run was performed

To attach a timestamp to the backup set:

From the left navigation menu in the backup wizard select Job Info.1.

Click Backup Filename Options.2.

Select Attach timestamp to backup set.3.

From the Timestamp format combo-box choose preferred date/time format.4.

Click Ok.5.

 

Timestamp formats

Timestamp formats are:

Month dd, yyyy@hh:mm:ss AM/PM

Day of the week, Month dd, yyyy

Month dd, yyyy

yyyy-mm,dd

Month dd

mm-dd-yyyy@hh-mm AM/PM

mm-dd-yyyy@hh-mm-ss AM/PM

hh.mm.dd AM/PM

 

 

 

 

 

Copyright (c) 2007 Genie-Soft, Inc. All rights reserved.



Rotating Backup Types

When increment backup is used, the user can set GMB to automatically switch to normal backup after a
specific number of increments. Each full backup and its subsequent incremental executions are treated by
GMB as one backup set, enabling the user to purge old backup sets safely.

To set GMB to limit the number of increments for each backup set:

From the left menu in the backup wizard, select Settings.1.

Click Purge Settings.2.

Select the Limit increments option.3.

In Number of increments, type the number of increments you wish GMB to perform before switching
to full backup.

4.
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Compression

Genie Mail Backup uses non-proprietary ZIP64 compatible compression to reduce backed up data size and
save space, supporting up to 264 -1 files within a zip archive as well as files that have a size greater than
4GB, for a zip file size that can reach up to about 18 million terabytes ( more precisely,   2^64-1 bytes).

The Genie Mail Backup compression engine offers fast performance and low memory usage. Speed
improvements reach 25%-75% in certain contexts. It also provides 15 to 20% better compression than
other formats on many popular file types, especially XML data.

Users can choose between 9 levels of compression ranging form no-compression, to best.

To set GMB to compress backed up data:

From the left navigation menu in the backup wizard select Settings.1.

Select Use Compression.2.

Select the desired compression level from the combo box.3.

 

Backup without Compression

Selecting to backup data without compression would cause GMB to copy the data to a folder on the storage
device while preserving the original file/folder structure, this makes data more accessible and less
susceptible to corruption.
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Power Management Options

Users can set Genie Mail Backup to trigger a power-saving event after a backup job has been executed.
Allowed options are:

Exiting Genie Mail Backup.

Shutting down computer.

Setting computer on Hibernate mode.

Logging off computer.

Setting computer on Stand-by mode.

 

To configure power-saving options for a backup job, select the Settings screen from the backup wizard, click
More Settings, then select Advanced Settings. Selected power-saving options must be supported by the
computer. To configure power management settings for your computer, double-click Power Options in the
Control Panel.
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How to: Create Backup Shortcuts on the Desktop

Users can create shortcuts on the desktop area for created backup jobs for easy access. Shortcuts also run
backup jobs without the need to go through the backup wizard.

To create a shortcut for a backup job:

Open Jobs Manager.1.

Select a backup job.2.

Click Create Shortcut.3.
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How to: Create Self-Restorable Backups

Genie Mail Backup offers users a feature that enables them to restore their backed up data to any machine
regardless of whether GMB is installed on it. Choosing Enable Self-Restorable backup option creates a
standalone self-executable .exe file on the storage media, which can be used to browse backed up data and
restore it on any machine, even if GMB is not installed on it.

 

How to Create a Self-Restorable Backup Archive?

Open the backup wizard.1.

From the left navigation select Settings.2.

Select Enable Self-Restorable Backup.3.

 

One-File SwiftRestore

If the data is backed up using compression, and is less than 200MB after compression, Genie Mail Backup
will turn the entire backup set into one self-executable file. Otherwise, the software will create a separate
.exe file in the same folder as the backup set; However, the user can specify to create a larger one file swift
restore file by the following steps:

Go to Tools, then select Global Preferences.1.

Click the plus icon next to Backup Settings then select Advanced Settings.2.

Make sure Enable one-file self-restorable backups is selected.3.

Select a preferred size from the drop-down menu, or type a custom value (maximum 2 GB).4.

 

Notes

One-file self-executable backups is not supported when backup data is spanned over multiple volumes
or forced to split.

 

Extracting the Backup Archive from a SwiftRestore File

If the SwiftRestore .exe file got corrupted, users can extract the backup archive from the self-executable file:

From the toolbar click Tools, then select Extract archive from .exe file.1.

Click Browse to locate and select the desired self-executable backup file.2.

3.



1.

2.

Click Extract. The extracted backup set will be stored in the same folder as the original SwiftRestore
.exe file

3.
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Command Line Parameters

Genie Mail Backup can be started with various command line parameters to execute different actions on a
particular backup job, such as loading and running a backup job, running the application minimized,
alternating between backup types, shutting down the computer after backup etc. The parameters can be
used to create shortcuts which start backup tasks automatically.

Syntax

GBM8 [-e] [-job "backup job name"] [-h] [-noexit] [-showlogfile] [-novalidate] [-bt|1 2 3 4] [-shutdown| 1 2 3 4]

 

Parameters

Command Result

-e Activate the Command Line engine.

-job "job name" Name of the backup job to be performed.

-novalidate Do not verify backed up data after backup.

-h Run the backup monitor minimized when backup starts.

-showlogfile Display backup log when backup is complete.

-noexit Do not exit Genie Mail Backup after backup.

-bt Specify backup type to be used with this backup run.

  -bt1 Force running the backup job in full mode (backup all selected files).

-bt2 Force running the backup job in increment mode.

-shutdown Choose power saving option to be executed when backup is complete.

  -shutdown1 Shutdown computer.

-shutdown2 Hibernate.

-shutdown3 Logoff.

-shutdown4 Standby.
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The Scheduler

Backing up data can take a lot of time depending on the size of the data intended for backup, during which a
large portion of the machine's resources are consumed by the backup application. To avoid interrupting work
or slowing down the machine while it is being actively used, users can schedule backup tasks to run
unattended at times that guarantee no interruptions to their work. Scheduling also insure that the data is
being backed up on a regular basis without user interaction. Scheduling Backups are Step 5 in the Backup
Wizard.
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Basic Schedule

Scheduling is step 5 of the backup process in the backup wizard, in this step you can select  how often you
wish the backup job to be executed. Available options are: Every few hours, Daily, Weekly, Monthly, Once,
and At Windows login.

How to schedule backup jobs in Basic Schedule?

From the left navigation menu in the backup wizard select Schedule1.

Check Enable Schedule, to enable schedule options.2.

Select how frequent you wish to run the backup:

Run Every Few Hours: runs  backup every few hours, in this option you can also specify the
days you wish the task to run

Run Daily: Runs backup daily at a specific time

Run Weekly: Specify the time and days you wish the backup to run

Run Monthly: Specify the time and day of the month

Run Once: Run this backup one time on a specific time

Run at Windows logon: Runs every time you logon into your computer

3.

Under Security Settings, you can specify if you wish to run the backup whether the user is logged on
or not. If you select Run whether user is logged on or not, you must enter the Windows login
username or password; otherwise your backup will not run if Windows is logged out.

4.

 In More Settings, you can specify the following options:

Minimize backup window when running job: Selecting this option runs the backup job while
scheduled backup window is minimized

Do not start backup if the computer is running on batteries: You can set this option that
tells the task to run only if the computer is on AC power (not battery power)

Do not wait 10 seconds before starting backup: By default the scheduled backup has a 10
second delay counter before actually running the backup. Choosing this option will enable to run
the task without this 10 second delay.

Wake up computer to run this task (if supported): If you computer is set to sleep at the
time of backup, you can choose to wake up the computer to run the task. This option is enabled
if Run whether user is logged on or not is enabled.

5.



The Backup Monitor

When running a backup job as a scheduled backup task or from a desktop shortcut the task will be run in a
small window called the Backup Monitor.

The Backup Monitor Controls:

Help: Opens the Help documentation

Show Log...: Displays the backup log, this option is only enabled after backup completes

Abort: Aborts backup progress

Status bar: This window will display the status of the backup task along with a bar indicating progress.

Pause: Pauses the backup, this option is enabled during the backup process

Stop Timer: Cancels the 10 second timer before backup starts, to start the backup manually, click Start
Backup

Snooze: Postpones the backup and runs it later specified in the Click Snooze to be reminded again in.
You can choose the to snooze for:

10 minutes: after 10 minutes run backup

30 minutes: after 30 minutes, run backup

1 hour: after an hour run backup

2 hours: after 2 hours run backup

8 hours: after 8 hours, run backup

1 day: run this backup the next day at the same time

Note:

You can only snooze before backup starts

Computer power options: Set or change the computer power options to be performed after backup
completes. These options are:

No Power option: do not perform anything after backup completes

Shutdown: Shutdown computer after backup completes

Logoff: Logoff computer after backup completes

Hibernate: Hibernate computer after backup completes

Suspend: Suspend computer after backup completes

For more information about power options, see Power Management Options



 

 

 



Run Backup

Users can run a backup job without going through the backup wizard by doing one of the following:

From the Tools menu in the main page, click Run Backup and select a job to run.

Create a shortcut on the Desktop for the backup job and double-click it whenever you wish to run a
backup task.
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Backup Progress

After the user selects Backup Now from the Selection Confirmation window, GMB will start the process of
backing up data. The Backup Progression window displays the status of the backup job, this information
includes:

Backup Job Name: Name assigned to the backup job.

Backup File:  The full path and filename of the output backup file/folder.

Backup Type: Backup type of this backup run (Full or Increment).

Backup Status: The current action being carried out  

Elapsed Time: Time elapsed since the user hit the Backup Now button.  

Actual Size: Actual size of processed data.

Compressed Size: Size of processed data after compression.

Processed: Number of new files being added to the backup set.

Updated: Number of processed files that have changed since the previous backup run.

Skipped:  Number of processed files that have not been added to the backup set due to errors.

Unmodified: Number of processed files that have not changed since the previous backup run.

Missing: Number of processed files that have been moved or deleted since the previous backup run.

 

 



Data Verification

Verification ensures that backed up data was successfully written on the storage media and that it can be
restored reliably. Genie Mail Backup will by default verify backed up data immediately after the backup task
is completed. But the user can also choose to test data integrity of a backup archive at a later time using the
Testing Data Integrity tool.

Testing data integrity is done using the following option:

Bit-by-bit verification: This is the default method used by GMB to verify that a backup archive is
restorable, and the data contained within it is not corrupt. This is done by reading every bit of each
backed up file, however, this verification method does not compare data to make sure that the backed
up and original files are exactly identical. This means that if the contents of a file in the backup archive
were modified after backup, Genie Mail  Backup will not detect it.

Genie Mail Backup will automatically verify backed up data when the user closes the backup summary dialog.
To change this behavior, click the Tools menu, select Global Preferences, select Test Data Integrity,
then choose one of the following options:

Automatically test data after backup: Always verify data after backup without asking me

Ask me: Ask me whether to verify data when backup is completed.

Do not test: Do not verify backed up data.

 

By default, after an incremental backup, Genie Mail Backup will only verify new and changed files that have
been added to the backup set, which saves time, based on the assumption that the rest of the data was
verified previously when it was first backed up.

To set Genie Mail Backup to verify the entire backup archive at the end of each backup execution, click the
Tools menu, then select Global Preferences, select Test Data Integrity, and make sure the option Test
only new and changed files is not selected.

To manually test a backup, make sure that the storage media holding the backup is connected, click the
Tools menu, select Test Backup, select the backup job which created the backup archive you wish to test,
then click Test now. Alternatively, you can directly select the backup by clicking Browse, navigating to the
location of the archive, and selecting the backup's ".gbp" file.

Post-backup data verification is not supported when the backup storage media is a remote machine using
FTP or when Online Backup is selected. However, in all cases, data is verified while it's being written to the
media.
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Data Integrity Testing Tool

The Data Integrity Testing tool verifies backed up data to ensure it can be reliably restored. To open the
Data Integrity Testing tool click Tools in the toolbar, then select Test Backup.

 

The Controls

Backup Jobs: List of executed backup jobs.

Backup Job: Name of backup job.

Status: Availability of the backup archive. If the media is not loaded, or the backup archive has been
moved, the backup will not be available for testing.  

Backup File: Path and filename of the backup archive.  

Refresh List: Refresh list of backup jobs and their statuses.  

Browse: Manually locate the backup archive you wish to test.  

Test Now: Perform data integrity test for the selected backup job from the list.  

View Test Log: Displays the log produced by a performed data integrity test.  

Settings: Open the data integrity testing settings page in the Global Preferences dialog.

Close: Close the Data Integrity Testing Tools dialog.  

Help: Open this help page.  
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Verifying New and Changed Files

By default, after an incremental backup run, Genie Mail Backupwill only verify new and changed files that
have been added to the backup set. This saves a lot of time, based on the assumption that the rest of the
data was verified previously when it was first backed up.

To set Genie Mail Backupto verify the entire backup archive (data created by most recent full backup along
with all subsequent increments), you can do the following:

From the tool bar, click Tools, then select Global Preferences.1.

Select Testing Data Integrity.2.

Make sure the option Test only new and changed files is marked.3.
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Managing Open Files

Genie Mail Backup ensures business continuity of all their mission critical data, by backing up opened or used
files by other users or applications; leveraging Microsoft's latest Volume Shadow-Copy Service (VSS)
framework, to permit consistent backup of open files without the need for additional applications or plug-ins.

This option works for Windows XP, Windows 2003, and Windows Vista operating systems only. To backup
open or locked files on Windows 2000, users must install Open File Backup Agent as an add-on.

Open File Backup agent is a utility that helps GMB capture files that are open, even if they are changing
during the backup, without locking users out of the applications or forcing them to log off the network, giving
your backup software the ability to protect ALL your mission critical data by giving it access to exclusive,
open or in use files. And ensuring business continuity by protecting your data in real time without causing
interruptions.  
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Volume Shadow Copy Service

The Volume Shadow Copy Service (VSS) provides the backup infrastructure for the Microsoft Windows XP
operating system, serving a mechanism for creating consistent point-in-time copies of data known as
shadow copies. Microsoft's VSS component allows GMB to backup opened files, resulting in a skipped-files
free backup.

 

Allowing VSS to handle backup of open files

From the toolbar click Tools, then select Global Preferences.1.

Select Open File Backup.2.

Select Use Volume Shadow Copy.3.

 

Limitation of Volume Shadow Copy Service:

Works only with NTFS formatted partitions.

Supported only under Windows XP, Windows Vista, and Windows Server 2003.
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Open File Backup Agent(OFB)

Genie Mail Backup Provides two options to ensure business continuity of all their mission critical data, by
backing up files even if opened or used by other users or applications. Genie Mail Backup utilizes the latest
technical innovations available. Leveraging Microsoft's latest Volume Shadow-Copy Service (VSS) framework,
to permit consistent backup of open files without the need for additional applications or plug-ins.

This option works for Windows XP and Windows 2003 operating systems only. For support for other
operating systems and some older legacy applications, users must install Open File Backup Agent as an add-
on.

Open File Backup agent is a utility that helps GMB capture files that are open, even if they are changing
during the backup, without locking users out of the applications or forcing them to log off the network, giving
your backup software the ability to protect ALL your mission critical data by giving it access to exclusive,
open or in use files. And ensuring business continuity by protecting your data in real time without causing
interruptions.  
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Using Open File Backup Agent

Open File Backup Agent (OFB) is easy to use, once activated, it will work in the background without the need
for user interaction.

Checking whether OFB Agent is installed:

From the toolbar click Tools, then select Global Preferences.1.

Select Open File Backup2.

The OFB status field will indicate whether OFB is installed or not.3.

 

Checking whether OFB is running:

Through the system tray, right click on the GMB icon and select Open File Backup and make sure the check
mark is next to Start.

From the toolbar click Tools, then select Global Preferences.1.

Select Open File Backup2.

The OFB status field will indicate whether OFB is installed or not.3.

 

 

Allowing OFB to handle backup of open files:

From the toolbar click Tools, then select Global Preferences.1.

Select Open File Backup2.

Click Start.3.

 

Or through the system tray, right click on the GMB icon and select Open File Backup then click Start.

 

Pausing OFB:

From the toolbar click Tools, then select Global Preferences.1.

Select Open File Backup.2.

Click Pause.3.



2.

3.

 

Or through the system tray, right click on the GMB icon and select Open File Backup Agent then click
 Pause.

 

Allowing Open File Backup to Backup Open Files From Remote Locations

Open File Backup can be set to handle open files while backing up data using Genie Mail Backup from a
network-connected machine. This allows centralized LAN-based backups for clients with potentially-open
files.

Perform the following steps on each network computer you intend to backup data from:

Install Open File Backup Agent.1.

Click Start, point to Genie-Soft, then Open File Backup Agent.2.

Right-click the Agent icon in the system tray then select Settings3.

Make sure Allow Network Access to This Computer is selected.4.

 

 

 

 

 

Copyright (c) 2007 Genie-Soft, Inc. All rights reserved.



How to: Load Backup from the Catalog

If you want to restore data from a backup that was created on the same computer you are restoring to, and
the original backup job configuration is still present, you can load the backup and browse backed up files and
folders even if the backup archive itself is not accessible at the time. This is also the case for restoring Online
Backups.

To load a backup using the catalog:

Open the Restore Wizard.1.

Under Select a file to restore, click the plus sign next to the name of the backup job to view a list of
all its backup executions.

2.

Select the backup run you wish to restore from.3.

Click Next to continue configuring the restore task.4.

Alternatively, you can do the following:

Open the Catalog.1.

Under History of backup runs, click the plus sign next to the name of the backup job to view a list of
all its backup executions.

2.

Right-click a backup execution and select Restore. This will open the restore wizard and load the
selected backup.

3.

Click Next to continue configuring the restore task.4.

Note:

Genie Mail Backup will try to locate the backup archive in the default backup destination configured in the
backup job. If GMB fails to find the archive, it will prompt you to insert/connect the media on which the
backup is stored, and select the folder containing the .gbp needed to restore the data.
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How to: Load Backup from the Archive

Backup catalogs ("index.gix" files) are saved locally and in the backup destination together with the backup
archive. When a backup job is executed, a new ".gbp" file is created, containing the catalog file and other
internal information needed by GMB to restore the data.

To load a backup in order to restore data from it, simply double-click the .gbp file corresponding to the
backup version you want to restore. Alternatively, you can open the Restore Wizard, click Browse to
navigate to the location of the .gbp file and select it, then click Open.

A special file naming convention is used by Genie Mail Backup to denote different backup versions/executions
of the same backup job. For more information, see Backup Types.
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How to: Restore Using SwiftRestore

Users do not need to have Genie Mail Backup installed in order to restore data from a self-restorable backup.
Simply run the self-executable ".exe" file located in the backup folder, click Extract (or Run) to extract the
backup archive to a temporary folder on your machine and open the restore wizard. Then click Browse to
select the .gbp file corresponding to the backup version you wish to restore, and click Next to select data
items you wish to restore. Finally click Next to restore your data.

If the entire backup archive was stored in a single compressed self-executable file, the SwiftRestore
.exe file will be named <backup job name>.exe.

If the backup archive is not compressed or consists of more than one file (such as in the case of
incremental backup, or when data is too big to fit into one .exe file), the self-executable file will be
named GMB8_SwiftRestore.exe.

 

Extracting the backup archive from a SwiftRestore file

If the self-executable .exe file got corrupted, users can extract the backup archive from the self-executable
file in order to restore using the Genie Mail Backup application:

Open Genie Mail Backup.1.

Select the Tools Menu.2.

Select Extract archive from .exe file.3.

Click Browse to locate and select the self-executable backup file.4.

Click Extract. The extracted backup archive will be stored in the same folder as the original
SwiftRestore .exe file.

5.
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How to: Restore Data?

My Mail:

How to: Restore Outlook Data

How to: Restore Outlook Express Data

How to: Restore Windows Mail Data

How to: Restore Windows Address book

How to: Restore Windows Contacts

How to: Restore Windows Favorites

How to: Restore Internet Explorer Settings

How to: Restore Windows Settings
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Logs and Reports

Genie Mail Backup offers a variety of detailed logs and reports that help users to keep track of what happens
during its various operations, the most important of which is backup.
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The Backup Log

The normal log is opened by default after each backup run. It displays a summary of the backup task's
settings and statistics, grouped into four sections:

Job information: selected backup job settings, including the job's name, backup destination, backup
type, etc.

Backup information: a breakdown of the types and sizes of the backed up data sources.

Backup summary: a summary of the types of processed files (new, modified, unchanged, deleted,
skipped) and errors encountered during backup.

Data integrity test: displays a summary of errors encountered during testing the integrity of each file
in the backup archive (if any).
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The Restore Log

To view the log file containing details about GMB's activity during restore click View Restore Log in the last
screen of the restore wizard

Their is only one restore log, which is overwritten during every restore task. The Restore log file is located in
the following folder:

Windows 2000/XP/2003: Drive:\Documents and Settings\%Username%\Application Data\Genie-
Soft\GMBAPPLICATION\Jobs\restore.html

Windows Vista:

C:\Users\USERNAME\AppData\Roaming\Genie-Soft\GMBAPPLICATION\Jobs\restore.html

 

 

 

 

 

Copyright (c) 2007 Genie-Soft, Inc. All rights reserved.



Data Verification Log

After using the Data Integrity Test tool to perform data verification on a backup archive, you can click the
View Test Log button to display an HTML file containing the test results. Any encountered errors will be
listed in the log.

For a complete list of backed up files and the status of each tested file, select Click here for a more
detailed log.
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GMB Trace Log

When trace log is activated, Genie Mail Backup logs all backup activities and dumps the verbose to a file, for
purposes of debugging. The file is typically located in:

Windows 2000/XP/2003: Drive:\Documents and Settings\%Username%\Application Data\Genie-
Soft\GMBAPPLICATION\Logs

Windows Vista:

C:\Users\USERNAME\AppData\Roaming\Genie-Soft\GMBAPPLICATION\Logs

Where X is the letter of the drive on which Windows is installed.

To activate the GMB trace log click the Tools menu, select Global Preferences, select General, select
Advanced, make sure Enable advanced logging for debugging is checked. Note that activating the trace
log will slightly slow down the program's operations.

The trace log is emptied every time Genie Mail Backup is restarted.
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VSS Trace Log

Genie Mail Backup logs all Volume Shadow Copy operations and stores them in a file typically located in

Windows 2000/XP/2003: Drive:\Documents and Settings\%Username%\Application Data\Genie-
Soft\GMBAPPLICATION\Logs\vsslog.log

Windows Vista:

C:\Users\USERNAME\AppData\Roaming\Genie-Soft\GMBAPPLICATION\Logs\vsslog.log

If you encounter a problem with backup while GMB is set to use Microsoft's Volume Shadow Copy service to
backup open files, submit this file to the Genie-Soft support team for debugging.
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Email Notification

If you are a network administrator who is always on the move, and you've scheduled backup jobs to run
while you're away, but still need to make sure everything goes smoothly, then email notification is the
feature you need.

E-mail notification is a nifty feature that enables GMB to send information to the user about the status of the
performed backup upon its completion via email.
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How to: Activate E-mail Notification

From the toolbar click Tools,then select Preferences.1.

Select Email Settings.2.

Select Enable e-mail notification.3.

Enter the following settings:4.

SMTP server: The name or IP address of SMTP server to be used for sending notification emails

Port: SMTP sending port. (25 by default)

SSL: SSL (Secure Sockets Layer) is a security protocol that provides communication privacy.
Select this option if your SMTP server supports this protocol.

From: The email address to appear in the From field of the sent notification email

To: The address of the recipient of the notification email

Subject: Enter the description that will appear in the Subject field on the sent email
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How to: Send Email Notifications

Make sure email notification is enabled.1.

From the left navigation menu in the backup wizard select Settings.2.

Click More Settings then select Email Notification.3.

Select Send e-mail notification.4.

Choose one of the following options:5.

When backup is complete: Send notification email when backup is over.

Only if error occurs: Send notification email only if GMB encountered a problem during backup
(skipped files, failed to create backup file, etc...)

Type a subject for the submitted email. If you do not manually enter a subject line, it will by default be
sent as "GMB Backup Notification"

1.
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SMTP Authentication

GMB supports different SMTP authentication methods for sending email notifications. SMTP authentication
uses different methods of encryption to protect the user mail account's name and password as they are
being sent to the SMTP server. If you do not know which authentication method your email server uses,
please consult your system administrator.

To choose an authentication method:

From toolbar, click Tools, then select Preferences.1.

Select Email Notification Settings.2.

Click Authentication Method.3.

Choose one of the following authentication methods:4.

NONE: Send the password to the server in an insecure format.

AUTH LOGIN: Most common authentication method.

CRAM MD5: (Challenge Response Authentication Mode), most secure authentication method.

LOGIN PLAIN: Sends authentication in plain text
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Sound Alerts

Genie Mail Backup can be set to play sound files to notify users when specific backup-related events take
place, such as when a backup task is completed, or when GMB prompts the user to replace a storage
volume.

To open the Sound Alerts settings page, click Tools, select Global Preferences, expand the General list,
then select Sounds.

To disable sound alerts, uncheck the Enable sound alerts option.

To attach a sound file to a predefined event, select the event from the list, select Attach sound to selected
event, then click Browse to select a sound file from your computer.

 

Events that support sound alerts are:

Finishing backup successfully.

Finishing backup with errors.

Completing data verification.

Prompting the user to replace disk during a multiple media backup.

Finishing data integrity testing.
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Scheduling Unattended Backup Tasks

Generic troubleshooting tips.1.

GMB Is requesting a username for scheduling an unattended backup although I do not use one.2.

Error Message: "Failed to create a scheduled backup job."3.

Error message: "0x80070005: Access is denied."4.

 

Generic troubleshooting tips

GMB uses Windows Schedule task to schedule the backup tasks. However, under certain circumstances,
Windows fails to run the scheduled tasks. Here are steps to troubleshoot scheduling issues.

Run the Job manually from GMB: If the scheduled task does start but encountered problems running,
open GMB and run the task from there as it may be a problem from the backup job itself. If you
encounter problems in the manual run, please contact technical support.

1.

Check the scheduled task status: If your scheduled tasks are running in different times than expected
or not running at all, check your scheduled tasks from Control Panel> Scheduled Tasks, remove all
unwanted schedules of the task or edit the schedule time of the schedule task by right-clicking the
scheduled task> properties> under the schedule tab you can edit the schedule. You can also edit the
scheduled tasks via GMB from Scheduled Wizard> Edit Existing Tasks. You can also check the Status
column in the Scheduled Tasks window. The following table describes the status types.

2.

Status Description

Blank The task is not running, or it ran and was successful. 

Running The task is currently being run.

Missed One or more attempts to run this task was missed.

Could not start The most recent attempt to start the task failed.

For details on the scheduled tasks status, go to step 4.

Run the job via scheduled Tasks: You can try to attempt a manual run from opening the scheduled task
in the task wizard> Right-click> Run and see if the tasks runs.

3.

Check the scheduled task logs for detailed tasks status: The Scheduled Tasks log (SchedLgU.txt),
enables you to view more information about the status of a scheduled task. This log file for Scheduled
Tasks is stored in the Windows folder, where it is used to record the activity of scheduled tasks. You
can use the log file to determine why a task might have stopped, by viewing errors that may have
encountered the task or to check on the status of a task. Usually, you can search the Microsoft
knowledge base http://support.microsoft.com/search/  with the error codes you are encountering and
find fixes and workarounds for common errors.

4.

Manually schedule the task: You may refer to the following knowledgebase article on how to manually
schedule unattended GMB backup tasks.

5.

http://www.genie-soft.com/asp/Community/KnowledgeArticle.asp?KBID=55

6.

http://www.genie-soft.com/asp/Community/KnowledgeArticle.asp?KBID=55


Schedule a Task non- related to GMB: Try scheduling a task that is not related to GMB so you can
identify if the problem is related to GMB or Windows.

6.

Back to top

 

GMB Is requesting a username for scheduling an unattended backup although I do not
use one.

SYMPTOMS:

Genie Backup Manger requests a username and password for scheduling an unattended backup task even
though mine is a standalone computer and no user name or password are required to log in.

CAUSE:

Your Windows has a login password, but its set to Null.

RESOLUTION:

Use the following when you are prompted to enter a username and password

User: {Username}
Password: Empty

Back to top

 

Error Message: "Failed to create a scheduled backup job."

If you are on a domain the user name must be written in the format Domain/Username. Also make sure that
the user name and password that you entered are the ones for the user logged onto the machine when the
backup job is intended to run.

GMB uses Windows Scheduled Tasks agent to schedule unattended backup jobs. Make sure that the
Scheduled Tasks agent is active by manually creating a scheduled task and running it once. For instructions
on how to do this, please follow the link below:

http://www.genie-soft.com/asp/Community/KnowledgeArticle.asp?KBID=55

In most cases, the user will get an error message that reads

"The new task has been created, but may not run because the account information could not be set. The
specific error is: 0x8007007a: The data area passed to a system call is too small."

This indicates that the buffer that stores account information for ALL scheduled tasks is finite, and has been
exhausted.

To work around this error:

Copy/Paste the following to a notepad file and name it StopStartTaskScheduler.bat:1.

http://www.genie-soft.com/asp/Community/KnowledgeArticle.asp?KBID=55


1.

@echo off
net stop "Net Logon"
net stop "Windows Time"
net stop "Task Scheduler"
net start "Windows Time"
net start "Net Logon"
net start "Task Scheduler"
@ping -n 901 127.0.0.1>nul
@echo You may set the account information for the 'new task' and schedule additional tasks.

Open a CMD prompt.2.

Type StopStartTaskScheduler.bat and press Enter.3.

When you see the You may set the account information for the 'new task' and schedule
additional tasks message, in 15 minutes, the Task Scheduler scavenger tool, which start 10
minutes after the Task Scheduler service is started, should have freed enough buffer memory.

4.

NOTES:

You may have to press OK in a dialog that tells you that some scheduled tasks have been missed.

When the script starts the Task Scheduler, it is normal to receive: "The requested service has already
been started."

Back to top

 

Error message: "0x80070005: Access is denied"

SYMPTOMS:

When I try to create a scheduled job manually from windows schedule wizard I get an error message that
reads “0x80070005: Access is denied”

CAUSE:

This problem also occurs because of a regression that was introduced in Windows XP Service Pack 2 (SP2)
and Windows XP Tablet PC Edition 2005.

RESOLUTION:

Please make sure that you are logged on into your user’s account with the correct password, Even though if
you are an administrator the scheduler will not recognize you as you are not logged on with admin password.

From Microsoft knowledge base :"A supported hotfix is now available from Microsoft, but it is only intended
to correct the problem that is described in this article. Only apply it to systems that are experiencing this
specific problem. This hotfix may receive additional testing. Therefore, if you are not severely affected by
this problem, we recommend that you wait for the next Windows XP service pack that contains this hotfix."

To download fix please use the following link:

http://www.microsoft.com/technet/security/bulletin/ms04-022.mspx

http://www.microsoft.com/technet/security/bulletin/ms04-022.mspx


To work around this problem:

Click Start, click Run, type Gpedit.msc, and then click OK.1.

Expand the following items in the Local Computer Policy list:2.

Computer Configuration

Windows Settings

Security Settings

Local Policies

Click User Rights Assignment.3.

Double-click Access this computer from the network, and then click Add User or Group.4.

Add the new user name or the group name in the Enter the object names to select area.5.

Click Check Names to verify the entries.6.

Click OK two times.7.

Back to top
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Backup Types

Error Message: "Missing index.gix file, can't continue without this file".1.

GMB is set to backup only new and changed files, but it reports the size of the entire set of
selected files and folders before backup, even though few files were added or updated.

2.

 

Error Message: "Missing index.gix file, can't continue without this file"

SYMPTOMS:

When backing up in incremental mode with compression disabled,  the backup can't find index.gix and
reports the error message:

"Missing index.gix file, can't continue without this file"

CAUSE:

Your previous backup run was interrupted.

RESOLUTION:

Run a full backup. This will recreate the index.gix file.

Back to top

 

GMB is set to backup only new and changed files, but it reports the size of the entire
set of selected files and folders before backup, even though few files were added or
updated

CAUSE

During the "confirming data selections" step before backup, Genie Mail Backup depends on the Archive
bit/flag attribute to determine which files have not already been backed up. If GMB was not able to reset this
flag during previous backups, for instance if the source was write-protected, it will assume that all files need
to be backed up. Note that this does not prevent GMB from actually backing up only the correct set of files in
real-time, as it refers to its own internal index.

RESOLUTION

If the data source was a network location, change the share permissions for folders that you've selected for
backup to "full control". Otherwise, please make sure that the source media is not write-protected.

Back to top

 



 

 

 

 

Copyright (c) 2007 Genie-Soft, Inc. All rights reserved.



Restoring a Self-Restorable Backup

Error message: "The application has failed to start because {MSVCP71.dll or MFC71U.dll} was
deleted. Reinstalling the application may fix the problem"

1.

Error message: "The application has failed to start because {MSVCP71.dll or
MFC71U.dll} was deleted. Reinstalling the application may fix the problem"

SYMPTOMS:

While trying to restore from a self-restorable (SwiftRestore) backup, the system displays an error saying that
a DLL file is missing.

CAUSE:

You have previously uninstalled a program that inadvertently deleted a files that is necessary for this
operation.

RESOLUTION:

Click HERE to download the file MSVCP71.dll

Click HERE to download the file MFC71U.dll

Place the downloaded file in the folder:
C:\WINDOWS\system32

Back to top
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Contacting Support

Even though we strive to make Genie Mail Backup easy to install and use, we understand that sometimes
you may need a helping hand.

Before contacting the support team, please take the time to collect the following information that will help
our team identify the problem and provide you with timely support:

Name of the product you are using and build number. You can find the build number by opening the
main application and going to Help > About.

1.

Windows platform the program is being used on.2.

Registration name and serial number if applicable.3.

Can the problem be consistently reproduced, if so what are the steps that can be followed to replicate
the error.

4.

 

You can contact the support team at Genie-Soft using the helpdesk call tracking system. Users must be
signed up with My Account in order to send inquiries (available for free for both registered and non
registered users). Sign up with My Account.

If you've forgotten your password, click on the Forgot your password? link in the My Account login page,
enter your email address, and click Send. An email will be sent to you. Click the link in the email to confirm
the request. The system will then automatically reset your password and send you another email containing
the new password.

Registered users can also:

Add (genie_soft@hotmail.com) on MSN messenger. Registered XP users may request remote
Assistance.

Contact the support technician through ICQ, UIN #266034018.

 

Using the Helpdesk

To access the helpdesk, log in to 'My Account'. From the My Account menu, select Helpdesk.

If you click on Main, a list of all open tickets will be displayed; click on a ticket's case number to view your
inquiry and the support technician's responses.

To submit a new inquiry, click on Submit New Request, complete the form, then click Send. To attach a
file to the call ticket, click Choose to select the file you wish to send from your computer, then click Attach.

Upon form submission, a ticket will be created in our call tracking system. When the support specialist
assigned to your call responds to your inquiry, an e-mail will be sent to notify you with a URL and a unique
ticket number that you can use to view the response. You can send a reply by writing a new message in the
text box at the bottom of the page, then clicking Send.
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Ordering Genie Mail Backup

Genie Mail Backup has a trial version. This means that you can evaluate a fully functional copy of the
software for FREE. You are entitled to evaluate the software for up to 30 days without obligation to pay.
After 30 days, if you decide to keep the software, you must pay for and register your copy with us.

There are also a number of 'incentives' for registering:

Removes the registration and license dialogs.1.

You can use the software after the trial period.2.

You can use the auto update feature to check for new software upgrades and fixes.3.

Receive priority customer support.4.

Free upgrade to any minor version (8.x)5.

Special offers on major upgrades after the one year period.6.

 

How to register / purchase:

To purchase the software point your web browser to http://www.genie-soft.com/store/store.html

 

Software Satisfaction Guaranteed

If for any reason you are not satisfied with software purchased directly from Genie-Soft, simply contact us
for a refund within 21 days of purchase.

For returns, please contact sales@genie-soft.com

Please note that shipping and delivery charges are non-refundable.

These terms and conditions apply only to Genie-Soft software purchased directly from Genie-Soft. If your
software was purchased through a different vendor, it must be returned to that vendor and is subject to the
return policies of that vendor.

 

Your Order Is Secure

Ordering through Genie-Soft. is certain to provide you with a safe and secure credit card transaction.

Your order is secure because we use Secure Socket Layer (SSL) encryption for every transaction.

 

 

 

http://www.genie-soft.com/store/store.html
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